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1 Legal notice

This document is an integral part of the software shipped by SeeTec (referred to
hereinafter as the vendor) and describes how to use and configure the software and the
associated components.

The German version of the document is the original version. All translations are based on
the German original.

Copyright

This document is protected by copyright. It is not permissible to pass on the information it
contains to third parties without the vendor's expression permission. Any infringements
will result in claims for damages.

Patent and copy protection

In the event of protection being provided by a patent, utility model or registered design, all
rights are reserved. Brand names and product names are trade names or registered
trademarks of their companies or organizations.

Address

SeeTec AG

Wallgartenstralle 3

D-76661 Philippsburg

Phone: +49 (0) 7256 / 8086-0

Fax: +49 (0) 7256 / 8086-15

Email: info@seetec.de

Internet: http://www.seetec.de

Subject to alterations, errors and misprints.


mailto:info@seetec.de
http://www.seetec.de/




2 Support

Reporting a software problem by email

» If you discover a software problem, report it using the helpdesk portal at
https://support.seetec.eu.


https://support.seetec.eu/




3 Introduction

Exploit hidden potential with SeeTec!

Many thanks for opting for a SeeTec software solution.

SeeTec is a leading vendor of video management software and has been developing and
distributing software solutions for security applications since the year 2000. SeeTec also
offers industry-specific solutions for transportation and logistics, retail and trade, financial
services and critical infrastructure and cities. These applications support the business
processes of our customers and allow hidden potential to be exploited, thus making them
more successful.

The Multi Solution Platform system concept provides the basis for this. In addition to the
core products SeeTec S50, S100, S1000 and Infinity, it includes a wide range of
expansion options and interfaces to numerous third-party systems in the fields of access
control and building management, for example. As a modular software construction Kit,
the Multi Solution Platform allows custom, industry-specific video solutions to be
implemented that are infinitely scalable over time.

SeeTec Cayuga, the sixth generation of our video management software, is an extremely
flexible series of products suitable both for small-scale projects involving only a few
cameras and for complex and extensive installations involving multiple servers and over
1,000 cameras.

In this User's Guide you will find information on the installation and configuration of the
Cayuga software and an overview of the frequently used functions.

Product lines

= SeeTec Cayuga S50/S50X: This is an attractively priced yet powerful entry-level
solution for small-scale projects involving up to 50 cameras.

= SeeTec Cayuga S100: This is the SeeTec solution for medium-sized installations. It
allows intelligent video analysis to be used and third-party systems to be integrated.

= SeeTec Cayuga S1000/S1000X: This is the successor to the SeeTec Enterprise
Edition — for projects involving up to 1,000 cameras. It allows distributed and
virtualized security infrastructures to be managed.

= SeeTec Cayuga Infinity: This is the flagship of the SeeTec Cayuga product series,
offering the most extensive functional scope. There is no limit on the size of the
projects that can be implemented.
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4 Functional overview

Cayuga consists of various services that communicate with each other within a closed

network and over the Internet. Installations are possible on multiple computers, and an

unlimited number of servers, clients and devices can be added to the system. In addition,

the database can be installed at multiple distributed sites (multicore) to ensure network

independence.

The system essentially consists of server applications and client applications.

= One or more server applications manage the connected devices and databases,
providing the clients with the required data.

= Aclient application has a user interface that makes one or more modes available to
the user (see below). Multiple client applications can access a single server
application.

Surveillance mode

In surveillance mode the live pictures of all of the connected cameras and the incoming
alarms are displayed. The cameras can also be controlled here. In addition, it is possible
to search the image data on the basis of specific criteria.

Archive mode

In archive mode the recorded image and event data (e.g. alarms) is displayed. The
recordings can be searched and exported.
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Event analysis
In event analysis mode the events that occur (e.g. alarms and user logins and logouts)
are displayed and can be analyzed.

Configuration mode

All settings and adjustments the client makes to the system are made in configuration
mode. These include, for example, multiple configuration of video sources (e.g. cameras),
user authorization management and user interface settings.



5

Installation

Information on installation

Setup types

5.1

|

| 2

| 2

Multiple VB scripts are used for the installation, so you should disable any active
virus scanners for the duration of the installation.

Cayuga must not be installed on a compressed drive, since this can result in
problems with the database. A drive on which Cayuga is already installed must not
be compressed subsequently.

Direct X is installed during the installation and may carry out a restart in the case of a
first-time installation. DirectX is required, for example, for joystick control and MPEG-
4/H.264 display. If you receive an error message telling you that DirectX could not be
installed, you can install it subsequently. You will find the setup file in the
3rdPartyTools folder on the SeeTec DVD. Use only this version that is shipped with
Cayuga.

Symantec software products (Norton Firewall(TM), Norton(TM) Internet Security,
etc.) should not be used on the Cayuga server, since these programs prevent
communication between the server services.

The use of web guards, behavioral monitoring, etc. (e.g. of virus scanners) is not
supported.

The SeeTec AutoUpdater is always installed.

Native-Client & Server. This installation type installs the client and server modules
on the computer (see also Standard installation). The installation of a server and
client on a computer is the prerequisite for the installation of further clients or
servers.

Native Client. This installation type installs only the client modules (see also Client
installation). Following installation, the client must be connected to the network with
the server (see also Configuration mode).

Distributed server. This installation type installs only the server on the selected
computer (see also Server installation). Following installation, the server must be
connected to the system by another computer with a client installed.

Custom. In a user-defined installation, it is possible to install only specific
components on a computer (see also User-defined installation)

System requirements

The performance requirements of the SeeTec server services depend, above all, on the
video volume transferred and the storage hardware. Intel® processors should be used.
An additional 25 MB of RAM should be available for each camera.

Please note therefore that the hardware requirements depend very greatly on the
configuration.

For each server a maximum of 80 devices can be integrated with 32-bit
operating systems and a maximum of 250 devices with 64-bit operating
systems. Depending on the configuration (high resolution/frame rate), this
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5.1.1

Hardware

Software

5.1.2

Hardware

Software

5.1.3

Hardware

number may also be reduced. There can be no more than 250 servers in a
distributed installation.

Client (32-bit/64-bit)

= Random-access memory (RAM): min. 512 MB
= Processor (CPU): Pentium 4 or better

= Hard disk space: min. 1 GB

= Dedicated graphics card

= Screen resolution: min. 1280 x 1024

= Gigabit Ethernet network connection

= Windows® 7 (Home Premium, Professional, Ultimate)
= Windows® 8

= Windows Server® 2008 Standard, Enterprise

= Windows Server® 2008 R2 Standard, Enterprise

=  Windows Server® 2012

Server (32-bit)

= Random-access memory (RAM): min. 2 GB

=  Processor (CPU): min. Intel DualCore with 2 GHz

= Hard disk space: min. 20 GB and additional storage space for image recording
= Screen resolution: min. 1280 x 1024

= Gigabit Ethernet network connection

= Windows® 7 (Home Premium, Professional, Ultimate)
= Windows® 8

= Windows Server® 2008 Standard, Enterprise

= Windows Server® 2008 R2 Standard, Enterprise

=  Windows Server® 2012

Server (64-bit)

= Random-access memory (RAM): min. 4 GB
= Processor (CPU): min. Intel DualCore with 2 GHz

10



Software

5.2

Installation

Hard disk space: min. 20 GB and additional storage space for image recording
Screen resolution: min. 1280 x 1024
Gigabit Ethernet network connection

Windows® 7 (Home Premium, Professional, Ultimate)
Windows® 8

Windows Server® 2008 Standard, Enterprise
Windows Server® 2008 R2 Standard, Enterprise
Windows Server® 2012

Standard installation

The standard installation installs the system with the client and server on a single system
("Native Client & Server").

| 2

v

vvyyvyy

Insert the data carrier in the drive.

If you have received a software version, copy it to the desktop of the computer on
which the software is installed and unpack the copy.

Double-click Setup to start installation.

Select the installation language.

You can configure the language of the user interface after installation (see also
Configuration mode).

Click OK to start installation.

Read the terms for end users, and then click Next.

Select the desired product (see also Introduction).

Select the destination folder.

11
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» Select "Native Client & Server" as the setup type (see also Installation).

SeeTec Cayuga - InstallShield Wizard

Server services

Specify connection settingz for the server zervices

M anagement service
Host: Part:

/@Céicvuga localhost £0000

IF address/host name for server communication

Host: IP addrezses/hozt names found:

192168.0.38 192.168.0.38

Pathz for image storage

Fath
../data

[ Using netwark. authorization

i < Back i Newt =

Size [GB)
Unlimited

=)

4dd

Delete

Cancel

| L

» Leave the port number of the management server unchanged at "60000".

» Select a network address so that the client can log in to the server.

The installation program suggests existing network addresses and host names to

you.

Neither the IP 127.0.0.1 nor the host name "localhost" may be used for

communication with the server.

» Inthe MDS zone configuration settings, edit the existing path to the image database

zone or add further image database zones.
» Click Next.
» Click Finish.

Cayuga is now installed on your computer. To find out how to start the program and

modules, see Login.

5.3 Native client installation

In the client installation, only the client is installed on the computer ("Native Client").

» Insert the data carrier in the drive.

If you have received a software version, copy it to the desktop of the computer on

which the software is installed and unpack the copy.
» Double-click Setup to start installation.

12




5.4

VVYyVVYYVYYVYY

Installation

Select the installation language.

You can configure the language of the user interface after installation (see also
Configuration mode).

Click OK to start installation.

Read the terms for end users, and then click Next.

Select the desired product (see also Introduction).

Select the destination folder.

Select "Native Client" as the setup type (see also Installation).

Click Next.

Click Finish.

The Cayuga client is then installed on your computer. To find out how to start the
program and modules, see Login.

Distributed server installation

In distributed server installation, the server with the database modules for the image
database is installed on a different computer from the already installed client and core
server. The distributed server reduces the utilization of the core server because the
image database is located partially or entirely on the distributed server.

In order to configure the sever, you need an installed and configured Cayuga client
and core server (see Standard installation).

| 2

v

vVvyyvyy

Insert the data carrier in the drive.

If you have received a software version, copy it to the desktop of the computer on
which the software is installed and unpack the copy.

Double-click Setup to start installation.

Select the installation language.

You can configure the language of the user interface after installation (see also
Configuration mode).

Click OK to start installation.

Read the terms for end users, and then click Next.

Select the desired product (see also Introduction).

Select the destination folder.

13
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» Select "Distributed server" as the setup type (see also Installation).

SesTec Cayuga - InstallShield Wizard @

Server services

Specify connection settingz for the server zervices

M anagement service
Host: Part:

P~
/@C Eifyﬂu ga 50000

IF address/host name for server communication
Host: IP addrezses/hozt names found:
192168.0.38 192.168.0.38 hd

Pathz for image storage

=)

Path Size [GB) Add
../data Unlimited

Delete

i

[ Using netwark. authorization

i < Back i Newt =

» Specify the IP address of the main SeeTec server as the host in the SeeTec
CoreServer area.

Neither the IP 127.0.0.1 nor the host name "localhost" may be used for

communication with the server.

» Leave the port number unchanged at "60000".

» Select a network address for the server.
The installation program suggests existing network addresses and host names to
you.

» Inthe MDS zone configuration settings, edit the existing path to the image database
zone or add further image database zones.

» Click Next.

» Click Finish.
The Cayuga server is then installed on your computer.

» Start the SeeTec Service Manager in the SeeTec Cayuga folder.

» Use the SeeTec Service Manager to start the services.
The distributed server connects to the main server automatically.

The required ports 60000 - 60008 for communication between the distributed server

and the main server must be open.

» Configure the system with the SeeTec client (see Configuration mode).

14
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55 User-defined installation

In a user-defined installation you can only install selected modules. It is also possible to
install a further core server in slave mode that serves as a failover and thus increases the
reliability of the core server.
To configure the user-defined modules, you require an existing installation of a
Cayuga client (see Client installation) and a Cayuga server (see Server installation).
» Insert the data carrier in the drive.
If you have received a software version, copy it to the desktop of the computer on
which the software is installed and unpack the copy.
» Double-click Setup to start installation.
Select the installation language.
You can configure the language of the user interface after installation (see also
Configuration mode).
Click OK to start installation.
Read the terms for end users, and then click Next.
Select the desired product (see also Introduction).
Select the destination folder.
Select "Custom" as the setup type (see also Installation).

v

vVvyyvyvyy

ISeeTec Cayuga - InstallShield Wizard @

Select Features

Select the features zetup will install

Select the features you want to install, and deselect the features you do nat want to install

@Céyuga =8 Cli onents Diescription

- [v] Client [32-bit) Auyailable clent-zide
[ Mabile client components
v iewer

=1+ Server components

-] Spstem Manager master

-] System Manager slave

| Device Manager & MediaDatabaszeService
[ ]UpdateService

- GatewayS ervice

[ TranzcodingService

-] Analytics

=[] Tonls

£97.81 ME of zpace required on the C diive
13428.23 ME of space available on the C diive

E < Back E et > E Cancel

» Select the desired services and features.

You can deselect services and features that are not required.
» Click Next.
» Click Finish.

15
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5.6

The modules and services are now installed on your computer.

Updating

Before a new version of the software for the client and server can be installed, the
existing installation has to be removed (see Uninstallation).

>
| 2

>

Exit the program.

Insert the data carrier in the drive.

If you have received a software version, copy it to the desktop of the computer on
which the software is installed and unpack the copy.

Double-click Setup to start uninstallation.

A dialog box appears in which you make a selection.

Select "Remove program" and then click Next.

All components of the program except for the configuration settings are deleted from
the hard disk and removed from the directory services.

Install the new version (see Installation).

The existing configuration settings are adopted automatically.

Optional uninstallation and updating

5.7

>
>
>

Open the Control Panel and select Programs and Features.

Klicken Sie auf Programm deinstallieren.

Select SeeTec, and then click Uninstall.

All components of the program except for the configuration settings are deleted from
the hard disk and removed from the directory services.

Install the new version (see Installation).

The existing configuration settings are adopted automatically.

Repair and uninstallation

| 2

Insert the data carrier in the drive.
If you have received a software version, copy it to the desktop of the computer on
which the software is installed and unpack the copy.

16
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» Double-click Setup to start repair or uninstallation.
A dialog box appears in which you make a selection.

SeeTec Cayuga - InstallShield Wizard Iﬁ

Welcome

tadify, repair, or remove the program.

whelcome to the SeeT ec Cavuga Setup Maintenance proaram. This program lets you modify the
cunrent ingtallation. Click one of the options belov,

L~
PCsyuga ...

@ Select new proaram features to add or select currently installed features to remove.

" Repair

ﬁ Reinztall all program features ingtalled by the previous setup,

" Remove

@ Remowe all installed features.

E E et > E Cancel

» Select the desired option.

» To update the program, select "Modify" and then Next.
This allows you to carry out a user-defined installation, in which you can install and
uninstall the modules and services you choose (see User-defined installation).

» To repair the program, select "Repair" and then Next.
Cayuga tries to repair and reinstall any damaged program components itself.

» Toremove the program from the hard disk, select "Remove" and then Next.

All components of the program except for the configuration settings are deleted from
the hard disk and removed from the directory services.

» To completely remove all traces of the program after uninstallation, delete the
remaining SeeTec folders in C:\Program Files manually.

Optional uninstallation

» Open the Control Panel and select Programs and Features.
» Select SeeTec, and then click Uninstall.

All components of the program except for the configuration settings are deleted from
the hard disk and removed from the directory services.

» To completely remove all traces of the program after uninstallation, delete the
remaining SeeTec folders in C:\Program Files manually.

17






6 Login

Once the system is installed, you have to log in on the client in order to use the installed
services.

» Start SeeTec Surveillance in the SeeTec Cayuga folder on the Start menu.

3N
©c dayudga

nspired sense

Server: locathost |

User: administrator |

Password |esss

¥ Advanced options V

Copyright © 2003 - 2013, SeeTec AG

» For the default user, enter the name of the user and the password.
Enter the password carefully. The system draws a distinction between upper and

lower case.
» Apply your entry by clicking the blue check mark.
The client is started in surveillance mode (see Surveillance mode).

Logging in for the first time

If you are logging in for the first time (i.e. without installing Cayuga beforehand), you have
to modify the default user password.

» Enter your new password.
» Deselect Enforce secure password if you do not require increased password

security (see also Configuring users).
» If necessary, enter a second password (see also Configuring users).

Advanced options

In the advanced options you can configure additional user management functions or log
in as a user with two passwords.

19
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» Click Advanced options in the login window.

Last used: Company {lacalnast] v
Server: |localhost | |s0000

User: |administrator |
Password: [eee |

Second password: | |

Commeni: -
[] Use Active Directory
Remember user name
Remember password
[] Log in automatically

[] Use NAT

Ok

From the drop-down list, you can select a different server in the network.

Enter a second password if you wish.

To access an Active Directory service in order to manage users, select Use Active

Directory.

» Select Remember user name and Remember password in order to avoid having to
specify the user data. The system enters the specified user name and password in
the login window.

» Select Log in automatically to go straight to the user interface when the program
starts up.

» Select Use NAT in order to use the client to access a different server over the
Internet.

If you forget the administrator's password and haven't added any users to the

administrator group, it is no longer possible to access the system configuration

settings.

vvyy

20



7 User interface

The Cayuga user interface is subdivided into four different sections:

= The mode bar (1), which allows you to select the modes (see Mode bar)

= The menu bar (2), which allows you to choose functions regardless of the mode
selected (see Menu bar)

= The main window (3) or "stage", which displays the mode functions selected and —
depending on which mode is selected — the Information tab in the lower part of the
window

= The control bar (4), which contains the tabs for controlling the contents of the main
window (see Control bar)

21
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7.1 Menu bar

7.1.1 The menu bar

1 2 3 4 5

ile View ools Info Help

67

The menu bar contains the menus you can use regardless of the mode you have

selected:

= File (1). Changes the settings of the client and switches the user (see File).

= View (2). Manages the settings of the connected monitors and the video wall as well
as the LPR master data (see View).

= Tools (3). Activates the write protection of recordings and multiple export of image
data (see Extras).

= Info(4). Displays information on the system and license (see Info).

= Help (5). Calls the Help system and provides options for solving problems (see User's
Guide).

= Screen background of the main window (bright) (5). This function makes the screen
background of the main window brighter.

= Screen background of the main window (dark) (6). This function makes the screen
background of the main window darker.

7.1.2 File

File
Client configuration
On this menu you can adjust the client's settings.
You can only modify the client configuration if you have administrator's rights.

» Choose Client configuration from the File menu, and then change the client's
settings (see Client configuration).

Change language

The Cayuga user interface is shipped in multiple languages:

» Choose Change language from the File menu, and then select the desired
language.
If you select the Windows default, the operating system's language environment is
used automatically.

» Click OK to apply your selection, and then restart the client.

Change password

You can subsequently change the user's password.

22



User interface

» Choose Change password from the File menu, and then enter the new password
for the current user.

» Also enter the security password (see also Login > Advanced options).
» Click OK to apply the password, and then restart the client.

Change profile

If multiple profiles are used (user profile, group profile, etc.), you can change to a different
profile. The profiles can be managed in configuration mode (see Profiles).
It is not possible to change profile when you are in configuration mode.
» Select Change profile and then the desired profile.
» Click OK to confirm.
The current profile is deactivated, and the selected profile with its user rights is
activated.

Change user

If multiple users are created, you can change to a different user.
It is not possible to change user when you are in configuration mode.

» Choose Change user from the File menu, and then select the user.
» Click OK to confirm your selection.

The current user is logged out, and the new user has to log in with a user name and
password (see Login).

Switch installation

If you have installed multiple independent SeeTec servers, you can connect to a different
SeeTec server.

It is not possible to connect to a different SeeTec server if you are in configuration
mode.

» Choose Switch installation from the File menu.
» Enter the server name or its IP address and the user name and password.
The current installation is terminated, and the selected installation is started.

Add SeeTec installation

Adds further servers to the existing client-server installation in order to provide access to

the devices connected to them.

Requirements

» The same server version has to be installed on all servers to which a connection is to
be established.

» All of the servers must support multi-installation login. A license must be available for
SeeTec multi-installation login.

» Choose Add SeeTec installation from the File menu, and then select the desired
server.

» If the server is not displayed, select New SeeTec installation, and then enter the IP
address or host name of the server.

» Click OK to confirm your selection.

Disconnect SeeTec installation

Disconnects connected installations from the current system.
» Choose Disconnect SeeTec installation from the File menu.

23
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» Select the SeeTec installations in the list that you want to disconnect from the current
system, and then click OK.

Tidy up list of SeeTec installations

Tidies up the list of SeeTec installations most recently called by the client (see also

Advanced options).

» Choose Tidy up list of SeeTec installations from the File menu.

» Select the SeeTec installations in the list that you no longer want to be available for
selection the next time you log in on the client, and then click OK.

Count analysis

The count analysis provides a graphical analysis of the objects (people or vehicles) that
have been in the selected area or have passed the tripwire.

Choose Count analysis from the File menu.

Enter a name for the query.

Select the channel and rule for the filtering of the results.

Specify the start time and end time for the query.

Select the interval for the query.

Select expert mode, if appropriate, and then specify the query criteria.

Click the New query button to start the query.

Select a chart type for displaying the result of the query.

Change to the Chart tab, select With input data to print the chart with numerical
values, and then click the Print button to print the selected query.

Select the export format, and then click the Export button to export the selected

query.

VYVVVYVYYVYYY

v

Client configuration

The settings of the client are stored locally in the profile. They can only be changed
by a user with administrator rights.

Network

» If the server does not respond quickly enough, increase the time limit in Timeout for
server requests (in seconds).

» Specify the UDP or TCP port for image transmission to transfer the streams of

images from the cameras from the SeeTec server to the client.

Limit the bandwidth if you are accessing servers with a low-bandwidth connection.

Select the CameraManagement by double-clicking it.

Limit the maximum bandwidth used to avoid overloading the network.

vvyy

Client

» Select Suppress warning about time difference to server to suppress a warning if
there are more than ten seconds of time difference between client and server.

» Select Suppress warning if screen resolution is too low to suppress a warning if
the screen used does not have a high enough resolution (see System requirements).

» Select Delete entities without confirmation in Configuration Mode to delete the
entity (camera, time template, alarm, button, etc.) without receiving a request for
confirmation when you click the Delete button in configuration mode.
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Input devices

User interface

Deselect Do not display warnings in configuration mode if there are
discrepancies in the streaming settings to suppress a warning if there are
discrepancies in the settings for standard and alarm recording in MPEG-4/H.264
recording, resulting in recording losses.

Make entries for Maximum number of alarms in archive mode and Maximum
number of events in event analysis mode.

For Alarm sequence, specify whether more recent or older alarms are to be
displayed first for processing in the alarm list.

Select Stop low priority alarms when a new alarm is activated if a new alarm is
activated in order to also adjust the alarm handling of low-priority alarms.

Specify the port number of the SIP base port (the default is "5060").

Specify the port number of the Audio RTP port (the default is "7000").

Select the client's audio input device and audio output device.

Regardless of this, incoming calls go via the operating system's default audio output
device.

Select Use echo and noise suppression to improve the sound quality.

Select Use microphone amplifier to increase the volume of the input device.

All of the existing SeeTec installations are displayed in the column on the left of the
Specific settings for SeeTec installation group.

Select the desired SeeTec installation, and then select the settings.

Select Use keep-alive packages, and then, if necessary, adjust the intervals at
which the client is to log in to the SIP or VolP server.

The default value for Keep-alive interval is 10 (s), and for Registration interval it is
3600 (s).

Enter the data stored on the SIP server in the SIP user data for SIP user name and
SIP password.

Enter any name for Participant name. The participant name is displayed as the
called patrticipant in archive mode.

Enter the IP address of the PBX server for Registration server and Outgoing

proxy.

All input devices such as joysticks that are connected to the system and available before
startup of the SeeTec client are displayed. Any combination of devices is supported.
Every device can be configured independently of the others.

| 2

>
>
>

Select from the list the device you want to configure.

The functions of the joystick are listed on the right-hand side of the dialog box.
Activate the device.

If necessary, activate the z-axis (depends on the hardware).

Press the joystick button to which you want to assign an action, and then select the
desired action.

Restrictions and special cases

The jog dial and shuttle wheel are supported in archive mode for the Axis T831x
control unit.

Up to 112 virtual buttons can be configured for the Axis T8312 control unit. To this
end, select the virtual buttons option.
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= The control unit has 9 buttons.

» If you want to assign an action to button 56, press button 5 and 6 in rapid
succession, and then select the desired action.

» Specify for Timeout (ms) the time period within which the two buttons must be
pressed.

The Videotec DCZ control unit is also supported with the following restrictions:

= Only 32 of 38 buttons can be used.

= Only the outer job dial can be used in archive mode.

7.1.3 View

The settings are stored locally and have to be made on each client and for each
Windows® login profile.

Adding a window

The "Add window" function allows you to distribute the display of the main window
("stage") to multiple connected monitors.
» Choose Add window from the View menu.
A second window opens.
» Move the window to the connected monitor.
The client saves the setting and makes it available when you log in again.
» To use multiple connected monitors, repeat these steps.

Display agent

The SeeTec display agent allows you to use standard PCs and monitors to create a full-
fledged remote-controlled video wall.

Keeping the aspect ratio

» Select Keep aspect ratio to adapt the camera image to the layer window.
The camera image may appear distorted.

» Select Keep aspect ratio again to display the camera image with the original aspect
ratio.

Video wall dispatcher

The video wall dispatcher can control associated monitors dynamically. You can drag and
drop camera images, layers, maps and web pages to display them on video walls. The
video wall dispatcher allows camera images and layers from patrols and alarm scenarios
to be diverted to the video walls.

LPR master data editor

In the LPR master data editor you can add, modify or delete license plates.

7.1.4 Extras

Multiple export of image data

If you want to export a large volume of archived image data in a single operation, you can
specify the settings required for this on this menu.
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» Choose Multiple export of image data from the Extras menu.
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» Select or deselect either all of the installed cameras or specific cameras.

» Specify whether the image data is to be exported to the server or the client.

» Specify whether only standard recordings are to be exported or whether alarm
recordings are to be exported as well.

» Specify the time period for the image data to be exported.

» To secure the exported image data using the default password, select Use default
password.

» If you want to use your own password instead of the default password, enter this
password and then enter it again.

» If the image data is to be exported to a client that has a low-bandwidth connection,
select Use bandwidth limit and specify the bandwidth limit.

» Specify the storage location of the exported image data, and then confirm your
selection by means of Select.

» To store the exported image data in separate folders by user, camera name and time
of export, select Create subfolders for user, camera name and time of export.

» To carry out the export at a specific time, select Select time for export, and then
specify a date and time for the export.

» To store the exported image data in folders of approximately the same size as the
expected file size, select Split export into multiple folders and specify the folder
size and maximum size of the image file.

Image data that exceeds the specified size is split into multiple files so that they can
be stored on data carriers such as CD-ROMs or DVDs.

» To carry out the export immediately, click the Export button.

» Close the window.
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Removing write protection from recordings

Recorded image data can be write-protected to prevent any important data from being
automatically overwritten.

» Choose Write protection of recordings from the Extras menu.

» Select the cameras to be checked to ascertain whether there is a write-protected
recording area.

» Click the Start query button to display any write-protected recordings of the selected
cameras.

» Select the areas in which write protection is to be removed from recordings.

» Click the Remove write protection button.

» Close the window.

7.1.5 Info

Activating a license online

You cannot activate or download the licenses unless you have a connection to
the Internet.

>
>

|

|

Choose Activate license from the Info menu.

Select Personalize license (to register it with your user data) if the license has not
yet been registered.

Or

Select Download license if an update has been carried out and a new license is
therefore required.

Enter your user data or installation number (INR), and then click OK to apply your
entries.

The client connects to the SeeTec registration server and transfers the license key to
the computer.

Displaying a license

» Choose Display license from the Info menu.

Information on the license is displayed, such as the maximum number of
cameras/devices that can be used, the concurrent client connections or the validity
period of the license (if it is a demo license).

7.1.6 Help

User's Guide

Starts the Help system on the starting page. In addition, there are also links for accessing
specific topics directly from tabs and dialog boxes.
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Start problem recording

7.2

7.3

If problems occur during operation, you can use the "Start problem recording" function to
record, comment on and save them.

(23] Proklemaufzeichnung [ = &J

ii] Aufzeichnung starten 6 = e -
» Choose Start problem recording from the File menu.
» Select Start recording and carry out the steps that led to the problem.
» As soon as you have carried out these steps, stop recording.
» If you want to add a comment to the recording, click Add comment (e.g the time,

behavior of the client and devices, etc.).
Specify where the file is stored.

v

The mode bar

The mode bar allows you to switch between

display modes.

= Surveillance mode (1). When you log in, the
system starts up in surveillance mode (see
Surveillance mode).
The number of alarms that have occurred is
indicated by a number in the icon.

= Archive mode (2). Here you can manage and
display recorded image data and search for
alarm events (see Archive mode).

= Event analysis (3). The event analysis facility
gives you a list of the events that have occurred
(see Event analysis).

= Configuration mode(4). Configuration mode is
for managing and configuring the video
sources, users and locations (see Configuration
mode).

The control bar

The control bar contains the tabs required, depending on the mode, for controlling the
display or for configuration. You will find descriptions of the tabs in the sections
describing each mode. Tabs cannot be moved. They remain anchored in position on the
control bar.
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Showing/hiding a tab

Search

» Click the gray triangle in the upper-right corner of a tab to hide the tab on the right-
hand edge of the screen.

Once the last tab on the control bar has been minimized, the available size of the
main window increases.

» Click the gray triangle on the tab on the right-hand edge of the screen to show the
tab.

The control bar then also appears again.

At the lower end of the control bar, there is a search function that helps you to find the
contents of the active control bar more quickly.
» Enter the term you are searching for, and then click the magnifying glass icon.
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8 Survelllance mode

Surveillance mode allows live images, alarms and patrols to be displayed and PTZ
cameras and other peripherals such as door openers to be controlled (see also User

interface).
» To change to surveillance mode, click the Configuration mode icon on the mode
bar.

Camera operation

You can control the functions of the camera using the control bar (see Camera image
controller) or using the controls on the Control tab (see Control).

» To operate a camera, select a camera in the main window.

You can recognize a standard recording by the green point that appears on the lower
right edge of the camera image in surveillance mode. You can recognize an alarm
recording by the red point that appears throughout the recording.

Tabs

The tabs allows you to set the layers of the existing cameras (see Main window).
Control bar

The control bar allows you to perform the following actions:

» Move the selected PTZ cameras and change the image detail using the digital zoom

function (see Control)

» Select the cameras created for each location (see Camera overview)

» Search for specific installed cameras
Alarm list

The Alarm list displays the alarms that have occurred in the order in which they occur.

The most recent alarms are displayed first.

» Switch between alarm and system messages by selecting the Alarm or System
button.

» Click the column headings to sort the alarm or system messages by the column
category.

» Click the heading of the Time column to sort the alarm in ascending or descending
order by the time of their occurrence

» Click the gray triangle in the upper-right corner of the alarm list to minimize the tab on
the right-hand edge of the screen.

» Click the gray triangle on the tab on the right-hand edge of the screen to show the
tab.

8.1 Main window

The main window for displaying the camera and object images is sometimes known as
the "stage" (see also User interface). The main window displays up to 20 layers at the
same time. The layers can be arranged evenly or with multiple larger and smaller images
so that the main layers are always available in a larger layer.
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Depending on the setting made, alarms that occur are displayed in a separate message
window ("toast messages").

Creating layers

>
>
>
>

|

On the title bar in surveillance mode, click the eye icon to display the desired display
type.

The selected display type is shown on a tab next to the eye icon.

Click the cross on the tab for the display type to close it again.

Select Add layer to display a further camera layer.

Select Open layer in new window to display the new layer on a second monitor
without layer tabs (see Layer).

Select automatic layer switching and the desired interval to switch between the
display types automatically after a certain interval.

Automatic image switching is stopped in the event of an alarm scenario and has to
be restarted.

|

Select Close all layers to close all open layers.

» Select Close layer to close the current layer.

Displaying objects

8.2

» To create the desired arrangement of layers, navigate to the desired location on the

Overview tab.

» Open a layer.

|

Drag the selected object to the desired position in the main window.

Camera image controller

You work with the images of the connected and configured cameras directly in the layer
in the main window ("stage"). These functions refer only to the control options offered by
the software.

PTZ cameras are operated using the controller.
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= Zoom (1). Enlarges the image detail with the help of the digital zoom function. The
image detail is enlarged or reduced in size using the scroll wheel on the mouse.

= Pan(2). Moves the image detail in the layer. The image detail can be changed using
the mouse pointer.

= Archive(4). Shows the pictures of the most recently saved interval. The length of the
interval is set in the camera'’s configuration settings (see Configuration mode).

= Audio (5). Starts the camera's audio mode (if it has one) and permits audio
recordings.

= Export(6). Exports the pictures or prints the image displayed.

= Fullscreen (7). Enlarges the image detail of the camera so that it fills the main
window. All menus except the camera menu are hidden.

= Video recording (8). Starts and stops recording. A slowly flashing button indicates
that recording is in progress. A rapidly flashing button indicates alarm recording.

ISearch

Here you can search the recording of the last 60 minutes for movements without
switching to archive mode.
The performance of the search in the selected image detail depends on the
performance capability of the client hardware, since the search is carried out
exclusively on the client.
» Select ISearch.

See iSearch to find out what else you have to do.
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8.3

Camera overview

The Camera overview tab displays all the cameras, maps, layers and web pages for

each of the company's sites.

» Click the small triangle in front of the name of the site to display all of the objects
assigned to this site.
All of the objects are displayed in the main window provided the display option
permits it (see Main window).

» Select an object from the list to display only this object.

Searching for an object

8.4

In the system's configuration settings, each object should have been given its own name.
» To search for a specific object, enter the name of the object in the Search text box,
and then click the magnifying glass icon.
The first object found is highlighted.
» Click the magnifying glass icon again to jump to the next object found.

Control

1 —@ ®— 1

2 — 3

The Control tab allows you to control the active cameras displayed in the main window.
There are four submenus available:

Joystick (1)

» Onthe menu bar of the Control tab, click the Joystick icon to switch to operating
mode for the cameras.
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The joystick function is the central function for operating the selected camera.
These functions are available only for PTZ cameras.

>
>

| 2

Buttons (2)

Patrol (3)

| 2

& o 4

Drag the Zoom slider (1) up or down to make the camera zoom in or out.
Select the required camera position (2) to pan the camera to a preset position.
Including the default position, ten positions are possible.

Select the camera image, and then use the joystick (3) to move the camera by
moving the bright spot in the desired direction.

Use the four direction arrows on the edge of the joystick to move the camera
incrementally.

Switch between daytime and nighttime vision (4) to get an image when light
conditions are poor, providing this is supported by the camera.

On the menu bar of the Control tab, click OK to switch to the display of the buttons
created.

The buttons the user is authorized to use are displayed.

Select the desired sequence by clicking the button.

3
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» On the menu bar of the Control tab, click the Patrol icon to switch to the overview of
the patrols configured.

Starting a patrol

» Select the desired patrol, and then click Play (1).

The specified cameras, preset positions, maps and layers are displayed one after
the other for a defined period of time.

Stopping a patrol
» Click Play (1) again to interrupt the patrol.
Pausing a patrol

» Click Pause (2) to pause a patrol.
The patrol is paused.

Canceling a patrol
» Click Cancel (3) to cancel the selected patrol.
Repeating a patrol

» Click Loop (4).
The patrol is repeated.

» Click Loop (4) again.
The repetition is canceled, and no more patrols are carried out once the current one
is finished.

Navigating between points in the patrol

» Click Next (5) or Back (6) to go to the next or previous point.
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Camera audio (4)

» On the menu bar of the Control tab, click the Camera audio icon to switch to audio
mode.

» Select VolP (4) or Camera (4) to switch between the audio system of the camera (if
there is one) and voice output over the network (Voice over IP).

» Move the sliders (1) for the microphone and loudspeakers to adjust the volume.

» To speak to a person from the address book of the existing users, enter the name of
the person in the text box (2), and then click the magnifying glass icon or select a
person from the list.

» Click the green phone icon to start the call.

» Click the red phone icon to finish the call.

The name of the person you are talking to, the person's location and the duration of
the call are displayed (3).
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9 Archive mode

The recorded data is displayed in archive mode. Here you can carry out comprehensive
analyses of the archived data.

» To change to archive mode, click the Archive mode icon on the mode bar.

» Select the camera or layer whose archived image data is to be displayed, or select

an alarm from the alarm list.
1 3 5 7 9 11 14 17

18

The archive player is available to you for navigating in the image data archive of a

camera. Alarm events are highlighted in red in the archive player.

The archive player has the following functions:

= Previous frame (1): Jumps to the event's previous i-frame.

= Play backward (2): Plays the archived event in reverse chronological order.

= Pause (3): Pauses the playing of the event.

= Play (4): Plays the archived event in the correct chronological order.

= Next frame (5): Jumps to the event's next i-frame.

= Real time (6): Plays the event in real time.

= Next alarm recording (7): Jumps to the camera's next alarm recording.

= Skip pause (8): Skips the pause between two recordings.

= Calendar (9): Opens a calendar window in order to navigate to a specific calendar
time (date and time).

= Update timeline (10): Displays the most recently recorded images immediately.

= Synchronized mode (12): When playback starts, the cameras are synchronized to
the time of the selected camera.

= Zoom in to timeline/Zoom out from timeline (13): Enlarges or reduces the size of
the display of the timeline. You can also zoom within the recording period by clicking
the timeline and then turning the scroll wheel on the mouse.

= Set start/end marker (14): Sets the start and end markers for a selected area of the
timeline (see Editing an area).

= Write protection (15): Sets write protection for the marked area of the timeline.

= Delete area (16): Removes the marked area from the timeline.

= Export (17): Exports the marked area as image data or as an AVI video file.

= Jog dial (18): Plays the sequence forward and backward. The further you turn the jog
dial to the right or left, the faster the sequence is played forward or backward.

Editing an area

» Click the camera icon next to the jog dial.

39



Cayuga Manual

VVVVYVYYVYY

9.1 IS

To specify an area on the timeline, click the Set markers icon.

Move the two bright edges of the period or the period under the area.
Click the Set markers icon again to specify the area.

Click the Delete area icon to remove the area from the timeline.

Click the Export area icon to export the area.

Select the required data format (Type), and then click OK.

Specify the required export settings (see Multiple export of image data).

earch

ISearch helps you to search for events in part of an image.

Creating a search area

|
>
>

ISearch in su
>

>
| 2

Select the camera image, and then select ISearch at the bottom of the image.
Select the duration of the recording.

Click the magnifying glass icon, and then select the shape of the area to be
monitored.

Click the camera image, and then drag the shape to the desired position.

A semi-transparent area is laid over the image in the selected position.

If you selected the polygon for this purpose, click a point in the image for each corner
and close the polygon by double-clicking the last point.

rveillance mode

Start recording in the camera image controller.

After the selected duration has elapsed, you receive a message about the changes
found in the selected area.

Click the Play icon to play back the recorded period.

Click the Pause icon to pause the recording.

ISearch in archive mode

Experten Modus

After you have specified the search area, limit the search to a period of the archived
recordings.

Click the date field (2), and then click the calendar icon (1 or 4) and specify the
recording period.

Select either Any kind of motion within the selected area or A single event,
depending on what you want to take into account.
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Select expert mode, if appropriate, which allows you to carry out fine tuning and
adapt the methods.

Start the search.
Use the job dial (5) to move around in the recorded period.

The further you turn the jog dial to the right or left, the faster the sequence is played
forward or backward.
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10 Event analysis

The event analysis facility gives you an overview of the events that have occurred in the
form of a list. Distinctions are drawn between user events, alarm events and system
messages. In addition, the camera usage of users can be tracked.

» To switch to the event analysis facility, click the Event analysis icon on the mode
bar.

» Click a column header in the main window to sort the events in ascending or

ascending order on the basis of the column's category (data/time, alarm,
description).

Filtering the analysis

» To filter the events on the basis of specified criteria, select the type of event you are
searching for on the control bar.

You can choose between the following events:
Alarms (events that occur)

Users (display of events that concern specific users)
Camera usage (display of events that concern a specific camera)

System messages (display of events that concern specific services)
» Select the desired events.

» Specify dates and times to define the time period.
» Start the query.

Only the events that meet the selected criteria are displayed in the main window.
Exporting the analysis

You can also export the result as a comma-separated file (*.csv).
» Export the result in order to analyze it in a spreadsheet program.

Searching for an event

» To search for a specific term or event, enter the term in the Search text box, and then
click the magnifying glass icon.
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11 Configuration mode

You need administration authorization to carry out configuration.

In configuration mode you make all of the settings for the hardware, network, company,

maps, alarms and users.

» To change to configuration mode, click the Configuration mode icon on the mode
bar.

Configuration wizard

You will find the configuration wizard on the starting page of configuration mode. This
helps you make settings for the hardware. You can use it to make basic settings for:
= Alarms (see Creating settings and Copying settings)

= Cameras (see Creating settings and Copying settings)

Additional settings

» See Company for further settings for the company.
» See Administration for further settings for maps, other hardware, user management,
etc.

11.1 Company

The Company tab allows you to configure your company's locations and the hardware
used at each location.

R i
34 14

Creating a location (1)

» To create a new location, click the Create location icon (1).
» Specify the name of the location, and then click OK.
The new location is displayed in the window of the tab.
Editing a location (2)
» To edit a location that has been created, select the location in the window of the tab.
» Click the Edit location icon.
Deleting a location (3)

» To delete a location and all of the associated settings, click the Delete location icon

).

The settings for this location are deleted.
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Displaying a location overview (4)

» Click a location on the Company.
» To display the settings for a location, click the Location overview icon.
All of the settings for this location are displayed.

11.2 Administration

11.2.1 Administration

On the Administration tab you can assign hardware (e.g. cameras), actions and the
authorization manager to the specified locations and manage new objects such as alarm
scenarios, for example.

Functions

Depending on the hardware and network architecture, you can configure the following

functions:

= Camera. This function allows you to configure and manage the camera hardware and
the associated video server.

= Other hardware. This function allows you to configure and manage additional devices.

= License plate groups. This function allows you to configure and manage the number
plate recognition function of the LPR module.

= Time management. This function allows you to configure and manage the time
templates to coordinate the standard image recording of individual or multiple cameras
as well as validity in alarm scenarios.

= Buttons. This function allows you to configure and manage the sequences of actions
that can be triggered in the controller in surveillance mode.

= Maps. This function allows you to configure and manage the maps of the site or
building under surveillance, including the location of the surveillance hardware.

= Video walls. This function allows you to configure and manage the number plate
recognition function of the LPR module. You can drag and drop camera images,
layers, maps and web pages to display them on video walls.

= Layers. This function allows you to configure and manage the layers of the main
window ("stage") in surveillance mode.

= Users. This function allows you to configure and manage the users.

= Groups. This function allows you to configure and manage the user groups.

= Profiles. This function allows you to configure and manage the user and group
profiles.

= Alarms. This function allows you to configure and manage the alarm scenarios.

= Patrols. This function allows you to configure and manage multiple cameras, set
positions, maps and layers one after the other for a user-definable time.

= Sequences. This function allows you to configure and manage the sequences of
actions in which multiple set positions are approached one after the other and/or
actions are triggered.

= Server. This function allows you to configure the device services.
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Editing menu

3

Configuration mode

System. This function allows you to configure and manage system-wide settings for
the network, automatic backups as well as communication settings and event
management settings.

There are four editing modes available on the Administration tab:

Create new object (1)
Configure object (2)
Delete object (3)
Duplicate object (4)

11.2.2 Camera

The Camera function on the Administration tab allows you to configure and manage the
video hardware:

Creating a new camera

vvyy

vVvyvyy

Select Camera on the Administration tab.

Create a new camera.

Enter the name for the new camera.

If you want to configure the new camera using the configuration wizard, select
Wizard in the dialog box.

Select the manufacturer and type of the camera.

Select an authorization, if required, and enter a user name and password.

Enter the host name or IP address of the camera.

Select the Device Manager, if applicable.

If multiple servers have been installed for storing the image data (see Distributed
server in the installation routine), the available servers are displayed.

If you want to adjust the IP address of the camera, select the camera's manufacturer
for Available IP installers, and then click IP setup.

The subsequent configuration of the network address of the camera depends on the
manufacturer's installation program. Note the associated documentation of the
installation program.

Click OK to confirm your entries.

The new camera is displayed in the camera overview.

Configuring a camera

| 2

Select the camera in the overview.
The settings of the camera are displayed in the main window.
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» To search for the camera in the overview, enter the name of the camera in the
Search text box, and then click the magnifying glass icon.

Network cameras consist of a camera unit and a video server unit. That is why the video

server and a camera are always displayed as the hardware. Accordingly, the settings of a

network camera are always subdivided into video server settings and camera settings.

The video settings include all of the connection-specific parameters, while the camera

settings include all of the image quality and image storage settings.

IP cameralvideo server configuration

General

» Select or deselect the camera.

» Enter the name, the type and the network address or host name of the network
camera.

» Select the protocol type (http or https), and then change the port number, if
necessary.

» To test the incoming camera signal, click the Browser button.

The browser starts up, and the camera image is displayed in the browser window.
The application programming interface (API) is identified automatically. If the API
version cannot be retained, ask SeeTec Support for the correct assignment of the
APl version to the camera firmware.

» If necessary, change the server for managing the devices (Device Manager server).
» Select the camera capture mode if the camera supports different capture modes.

» Apply the set values if you want to make further settings.

» Save the set values to apply the values and conclude input.

Digital inputs

» Select the digital inputs and specify unique names for Name for CLOSED and Name
for OPEN.

» Specify the interval for the dead time (in seconds) after which a signal is analyzed
again.

That prevents the event database from becoming unnecessarily large when there
are events in rapid succession.

» Apply the set values if you want to make further settings.

» Save the set values to apply the values and conclude input.

Digital outputs

» Select the digital outputs and specify unique names for Name for CLOSED and
Name for OPEN.

» Specify the hold time for the time (in seconds) within which an output is opened or
closed (0 = infinite).

» Apply the set values if you want to make further settings.

» Save the set values to apply the values and conclude input.

Camera -name of the camera-

General

» Select or deselect the camera.

» If necessary, change the camera ID and adapt the ID of the associated camera to
the hardware.
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Special case: If the camera does not have its own PTZ control unit, you can redirect the
control signals of a video encoder to another camera with a connected PTZ control unit. A
separate RS-485 port of the video encoder is required for each redirection.

» To integrate a connected control unit, select PTZ as the camera type.

» Select Display title if you want a title to be displayed in the camera image, and then
enter the title.

» Select whether the date and time are to be displayed in the camera image.

» If the camera was not mounted upright, you can use the Rotate image function.
You can rotate the image in 90° steps (90°, 180°, 270°).

» Select Display buffer and specify the required size (0-1000 ms).

If you use the display buffer, the images from the camera are buffered on the
SeeTec client before they are displayed. This normalizes fluctuations in the live
display in terms of the intervals between different images. These occur, above all,
with cameras that have a low-bandwidth connection.

» Select Control camera if you are configuring a PTZ camera or a control unit to give
the user the option of controlling the camera in surveillance mode.

» Specify the PTZ sensitivity of the camera control.

» Select the camera position to give the user the option of moving the camera using
the PTZ control field and preset positions in surveillance mode.

» Select Invert PTZ control to correctly control cameras that are mounted upside
down.

» Select Pan/tilt mode.

» If the camera has a wide-angle lens (fisheye), select the manufacturer of the
camera.

» Make a selection for Action in the case of inactivity to specify which action is to be
performed if the camera is inactive.

The selected action is displayed.

» Specify for Timeout the time after which the action is to be performed if the camera
is inactive (in seconds).

» Make selections for Action at start of video stream and Action when the video
stream is stopped to specify the actions to be taken when the video stream starts
and stops.

The selected actions are displayed.

» Make a selection for Action in the case of inactivity to specify what is to happen if

the camera is inactive.

The selected action is displayed.
» Apply the set values if you want to make further settings.
» Save the set values to apply the values and conclude input.

Image storage
All of the image storage settings (e.g. which multimedia database is used or the size of a
camera's storage area on the hard disk) are configured here. To prevent sensitive image
data from being overwritten, standard and alarm recordings are configured separately.
» Select whether standard recordings are to be carried out with this camera.
» Select the recording period.
You specify the exact period using a time template that you create in the Time
Manager. By default, continuous recording is started ("Always").
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| 2

vVvyy

| 2

Select the time limit and enter the maximum storage duration.

If there is not enough storage space, the oldest recording is deleted and replaced
with the current recording.

You can specify a condition for starting image recording.

Select whether alarm recordings are to be carried out with this camera.

Select the time limit and enter the maximum storage duration.

If there is not enough storage space, the oldest recording is deleted and replaced
with the current recording.

Specify a pre-alarm duration (up to a maximum of 3600 seconds) for alarm
recording to record a period before the alarm is triggered.

Specify a maximum post-alarm duration (up to a maximum of 3600 seconds) for
alarm recording to record a period after the alarm is triggered.

The maximum post-alarm duration has no effect on alarm recording that is
triggered by an alarm scenario.

|

| 2
>

Select automatic deletion of the standard recordings or alarm recordings after a
specific timespan (Standard recording data aging or Alarm recording data
aging).

Specify the time limit after which the recordings are to be compressed and released
from the audio track.

Specify the frame rate (in fps) at which the recordings are to be stored after the time
limit is exceeded.

This reduces the image data to the set frame rate.

Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

Video streams
In the video streams you can specify and configure different profiles for the transmission
of image data. The software creates a base profile during installation.

» Click New to create a new video stream.
» Select the video stream, and then click Edit to make the required settings.
» Select the capture mode.
Depending on the setting selected, the camera provides different frame rates and
resolutions. The camera may restart and then be inaccessible for a few minutes.
» Select the type of the video stream.
The selected video codec is displayed.
MPEG-4/H.264 streaming is manufacturer-specific and is therefore not supported by
all cameras.
The screen saver of the client computer must be disabled for MPEG-4/H.264
streaming.
» Select the transmission mode.
» Select the transmission of audio signals.
» Specify the frame rate (fps) and image quality (as a percentage of the best possible

quality) separately for standard and alarm recording.

When there are differences in the settings for standard and alarm recording in
MPEG-4/H.264 streaming, it can take several seconds to switch from standard to
alarm recording. The length of time taken depends on the camera. There may be no
recording available during this period.

» Select a suitable resolution for the camera image.
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Specify the maximum bandwidth to be made available between the camera and
SeeTec server.

By default, the video stream is transmitted at a maximum of 4096 kbps.

Make a selection for Bandwidth control to specify whether a constant or variable bit
rate is to be requested from the camera (depends on the camera type).

Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

Audio settings

| 2

Select a suitable audio codec for the camera to specify sound transmission.
The voice quality for the G711 codec in VolP corresponds roughly to the sound
quality of the ISDN standard.

The voice quality for the G726 codec in VolP corresponds roughly to the sound
quality of a cordless phone (DECT).

Video gateway

| 2

| 2

| 2
>

Select Gateway, and then specify the port number if intelligent image analysis is to
be carried out by a via:sys box from viasys | Intelligent Video GmbH.

Select multicast streaming to display the video streams simultaneously on multiple
clients.

Enter the network address and port number of the multicast server.

Specify the validity period (TTL) after which the client has to log in to the multicast
server again.

A short TTL results in a higher network load.

Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

Camera positions

vvyyvyy

>
>
>

Use the joystick to move the camera to the required position.

Click the New button.

Click the number of the preset position to be moved to with the new camera setting.
Enter the name of the new preset position and click OK.

The name is displayed in the column.

To remove a preset position, select the name in the list and click the Delete button.
Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

Image data export

| 2

Specify whether standard recordings and alarm recordings are to be exported
automatically.

The time and path for the export are specified in the MDB configuration.

|

| 2

| 2

>

Specify the recording period to be exported.

You specify the exact period using a time template that you create in the Time
Manager.

Specify whether the camera name and time of recording are also to be exported in
the AV export.

The camera name and time are specified in the exported sequence at the bottom of
the image.

Select Reduce resolution to reduce the image quality, if necessary, and thus also
the data volume.

Select the maximum resolution for the export.
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Specify whether the length of the recording is to be limited.

Specify the maximum length of the recordings (in seconds).

Select Reduce frame rate separately for the video settings and single-image
sequences in order not to export all of the images of the recordings.

Specify the maximum frame rate (in fps).

Select Create ZIP file to compress the exported data after export.

Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

Camera motion detection

» Select the desired number of motion detection windows.
The motion detection windows must be configured on the camera directly.

» Specify the interval for the dead time (in seconds) after which a signal is analyzed
again.

» Apply the set values if you want to make further settings.

» Save the set values to apply the values and conclude input.

Tampering

Depending on the camera model used, specific events can be used as triggers for an
alarm scenario.

>

>
| 2

Specify whether, if there is tampering with the camera or the video signal is lost,
notification is to be sent to the server automatically.

An action can be started once notification is received.

Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

Privacy masking settings

Sensitive areas or movements in the image can be hidden by means of a mask. This
prevents the user from seeing these areas. Depending on the user authorizations, the
mask is displayed in surveillance mode and archive mode.

>
| 2

| 2

| 2

Select privacy masking.
Select the Static objects or Scrambling tab.
You can use the Static objects method to mask fixed individual areas of the camera
image. The masking follows the camera so that it is always the same image detail that
is masked.
The Moving objects method of the Scrambling function allows you to mask moving
objects or people. If a person, for example, stops, the masking is immediately
removed.
Office mode of the Scrambling function masks all differences from a reference image.
Static objects:
Select the Static objects function and select the shape of the area to be hidden.
Select the transparency, color and shape of the mask, and then drag the shape over
the camera image.
You can select either Delete to delete a single masking or Delete all to delete all of
them.
Moving objects:
Select the Scrambling function and specify how long the object is to be masked for
after it comes to a halt (Masking duration), the pixel size to be used for masking
(Masking) and how sensitive the response is to a moving object (Sensitivity).
Select Black and white to display the mask in black and white.
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Office mode:

Select Office mode, and then load a reference image. All differences to the stored
reference image are masked.

To delete all maskings in the archive, click Delete history and then Yes to confirm.
Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

Deleting a camera

>
| 2

|

Select the camera in the overview.

To search for the camera in the overview, enter the name of the camera in the
Search text box, and then click the magnifying glass icon.

Click the Delete object icon.

All saved recordings of the camera are deleted.

Duplicating a camera

| 2
>

Select the camera in the overview.

To search for the camera in the overview, enter the name of the camera in the
Search text box, and then click the magnifying glass icon.

Click the Duplicate object icon, and enter the name for the duplicated camera.
If you want to configure the new camera using the configuration wizard, select
Wizard in the dialog box.

Click OK to accept the name.

The new camera is displayed in the overview.

11.2.3 Other hardware

The Other hardware function on the Administration tab allows you to configure and
manage additional devices:

Creating new hardware

>
>
>
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Select Hardware on the Administration tab.

Create a new hardware item.

Enter the name for the new hardware.

If you want to configure the new hardware using the configuration wizard, select
Wizard in the dialog box.

Select the manufacturer and type of the hardware.

Select an authorization, if required, and enter a user name and password.
Enter the host name or IP address of the device.

If necessary, select the Device Manager.

Click OK to confirm your entries.

The new hardware is displayed in the overview.

Configuring hardware

|

Select the hardware in the overview.

» To search for the hardware in the overview, enter the name of the hardware in the

Search text box, and then click the magnifying glass icon.
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|

Edit the settings for the hardware.

Deleting hardware

| 2
>

| 2

Select the hardware in the overview.

To search for the hardware in the overview, enter the name of the hardware in the
Search text box, and then click the magnifying glass icon.

Click the Delete object icon.

Duplicating hardware

| 2
>

Select the hardware in the overview.

To search for the hardware in the overview, enter the name of the hardware in the
Search text box, and then click the magnifying glass icon.

Click the Duplicate object icon, and then enter the name for the duplicated
hardware.

Click OK to accept the name.

The new hardware is displayed in the overview.

11.2.4 License plate groups

The License plate groups function on the Administration tab allows you to configure and
manage license plate recognition (LPR):

Creating a new license plate group

vVvyyvyy

Select License plate group on the Administration tab.
Create a new license plate group.

Enter the name for the new license plate group.

Click OK to accept the name.

The new license plate group is displayed in the overview.

Configuring a license plate group

| 2
>
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Select the license plate group in the overview.

To search for the license plate group in the overview, enter the name of the group in
the Search text box, and then click the magnifying glass icon.

Select license pate recognition.

If necessary, alter the name of the license plate group.

Adjust the font color and background in the display of the license plate.

Select XML export to export the license plate data as an XML file.

Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

Deleting a license plate group

>
| 2

Select the license plate group in the overview.

To search for the license plate group in the overview, enter the name of the group in
the Search text box, and then click the magnifying glass icon.

Click the Delete object icon.
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Duplicating a license plate group

>
| 2

Select the license plate group in the overview.

To search for the license plate group in the overview, enter the name of the group in
the Search text box, and then click the magnifying glass icon.

Click the Duplicate object icon, and then enter the name for the duplicated license
plate group.

Click OK to accept the name.

The new license plate group is displayed in the overview.

11.2.5 Time Manager

The Time Manager function on the Administration tab allows you to create time
templates that are similar to a schedule in order to coordinate the standard image
recording of individual or multiple cameras as well as validity in alarm scenarios and user
groups.

Creating a new time manager

vvyyvyy

Select Time Manager on the Administration tab.
Create a new time manager.

Enter the name for the new time manager.

Click OK to accept the name.

The new time manager is displayed in the overview.

Configuring a time manager

>
| 2

Select the time manager in the overview.

To search for the time manager in the overview, enter the name of the time manager
in the Search text box, and then click the magnifying glass icon.

In the calendar, select the periods in which actions are to be performed by holding
down the mouse button and dragging the mouse pointer over the period.

Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

Deleting a time manager

| 2
>

>

Select the time manager in the overview.

To search for the time manager in the overview, enter the name of the time manager
in the Search text box, and then click the magnifying glass icon.

Click the Delete object icon.

Duplicating a time manager

| 2
>

Select the time manager in the overview.

To search for the time manager in the overview, enter the name of the time manager
in the Search text box, and then click the magnifying glass icon.

Click the Duplicate object icon, and then enter the name for the duplicated time
manager.
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11.2.6

» Click OK to accept the name.
The new time manager is displayed in the overview.
Buttons

The Buttons function on the Administration tab allows you to start specified actions such

as camera recordings or alarm scenarios.

Creating a new button

vVvyyvyy

Select Buttons on the Administration tab.
Create a new button.

Enter the name for the new button.

Click OK to accept the name.

The new button is displayed in the overview.

Configuring a button

General

Action

|
>

vy

vvyvyy

v
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Select the button in the overview.
To search for the button in the overview, enter the name of the button in the Search
text box, and then click the magnifying glass icon.

If necessary, alter the name.

Specify the sort order of the buttons in the controller in surveillance mode (see
Buttons).

The buttons are automatically sorted in ascending order. In other words, the higher
the number of a button, the lower down it appears in the list on the tab.

Select an icon to make it easier to recognize.

Activate the action for a specific camera, and select the camera.

Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

Select the Call URL option, and enter the Internet or intranet address.

Camera scripts cannot be started under this address, for example.

Click the Test button to check that the specified URL works.

Select the Perform action option and then the action.

If a second action is to be performed, select Perform next action and then the
action.

Select the Start alarm scenario option and then the alarm scenario (see Alarms).
Select the Terminate alarm scenario option and then the alarm scenario (see
Alarms).

Select the Start patrol option and then the patrol (see Patrols).

Select the Run program option, and then click the Select button to select a program
to be started.

Enter any parameters required by the program.

A document can be opened using the selected program, for example.

Apply the set values if you want to make further settings.
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Save the set values to apply the values and conclude input.

Deleting a button

>
>

| 2

Select the action in the overview.

To search for the action in the overview, enter the name of the action in the Search
text box, and then click the magnifying glass icon.

Click the Delete object icon.

Duplicating a button

>
>

Select the action in the overview.

To search for the action in the overview, enter the name of the action in the Search
text box, and then click the magnifying glass icon.

Click the Duplicate object icon, and enter a name for the duplicated action.

Click OK to accept the name.

The new action is displayed in the overview.

11.2.7 Web pages

The Web pages function on the Administration tab allows you to embed web pages in the
layer (e.g. webcams or intranet pages).

Creating a new web page

vvyvyy

Select Web pages on the Administration tab.
Create a new web page.

Enter the name for the new web page.

Click OK to accept the name.

The new web page is displayed in the overview.

Configuring a web page

>
| 2

|
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Select the web page in the overview.

To search for the web page in the overview, enter the name of the web page in the
Search text box, and then click the magnifying glass icon.

If necessary, alter the name of the web page and enter the URL (Internet or intranet
address).

Click the Test button to check that the web page can be accessed.

Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

Deleting a web page

>
| 2

|

Select the web page in the overview.

To search for the web page in the overview, enter the name of the web page in the
Search text box, and then click the magnifying glass icon.

Click the Delete object icon.
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Duplicating a web page

>
| 2

Select the web page in the overview.

To search for the web page in the overview, enter the name of the web page in the
Search text box, and then click the magnifying glass icon.

Click the Duplicate object icon, and then enter the name for the duplicated web
page.

Click OK to accept the name.

The new web page is displayed in the overview.

11.2.8 Maps

The Maps function on the Administration tab allows you to configure and manage the
maps of the site or building under surveillance, including the location of the surveillance
hardware.

Creating a new map

vVvyyvyy

Select Maps on the Administration tab.
Create a new map.

Enter the name for the new map.

Click OK to accept the name.

The new map is displayed in the overview.

Configuring a map

|
>
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Select the map in the overview.

To search for the map in the overview, enter the name of the map in the Search text
box, and then click the magnifying glass icon.

Click the Background image button, and then select the desired background image
(e.g. building floor plan).

Drag the cameras required for the desired site from the list to the background image.
Use the slider to set the relative size of the camera and the angle of view.

You can also set the exact angle of view by entering the angle in the text box.

Use the slider to set the angle of rotation.

Select Mirror to mirror the angle of rotation on the vertical axis.

Select Display text to display the name of the camera in the image.

Click the Delete button to remove the camera and all its settings from the image.
Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

Deleting a map

|
>
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Select the map in the overview.

To search for the map in the overview, enter the name of the map in the Search text
box, and then click the magnifying glass icon.

Click the Delete object icon.
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Duplicating a map

>
>

Select the map in the overview.

To search for the map in the overview, enter the name of the map in the Search text
box, and then click the magnifying glass icon.

Click the Duplicate object icon, and then enter a name for the duplicated map.
Click OK to accept the name.

The new map is displayed in the overview.

11.2.9 Video walls

The Video walls function on the Administration tab allows you to control the screens
connected to the network dynamically and display camera images, layers, maps and web
pages on video walls in dispatcher mode.

Creating a new video wall

vvyyvyy

Select Video walls on the Administration tab.
Create a new video wall.

Enter the name for the new video wall.

Click OK to accept the name.

The new video wall is displayed in the overview.

Configuring a video wall

>
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Select the video wall in the overview.

To search for the video wall in the overview, enter the name of the video wall in the
Search text box, and then click the magnifying glass icon.

If necessary, alter the name of the video wall.

Select the background image to be displayed on the video wall.

Drag the desired video wall (see Other hardware) to the background image, and
adjust the arrangement of the monitors.

Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

Deleting a video wall

| 2
>
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Select the video wall in the overview.

To search for the video wall in the overview, enter the name of the video wall in the
Search text box, and then click the magnifying glass icon.

Click the Delete object icon.

Duplicating a video wall

| 2
>

Select the video wall in the overview.

To search for the video wall in the overview, enter the name of the video wall in the
Search text box, and then click the magnifying glass icon.

Click the Duplicate object icon, and then enter the name for the duplicated video
wall.
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» Click OK to accept the name.
The new video wall is displayed in the overview.

11.2.10 Layers

The Layers function on the Administration tab allows you to adapt the main window
("stage") to suit your requirements in surveillance mode. These layers can be assigned to
a user or group profile and are available after the program starts up.

Creating a new layer

Select Layers on the Administration tab.

Create a new layer.

Enter the name of the new layer and the number of fields.
Click OK to accept the name.

The new layer is displayed in the overview.

vvyvyy

Configuring a layer

» Select the layer in the overview.

» To search for the layer in the overview, enter the name of the layer in the Search text
box, and then click the magnifying glass icon.

If necessary, alter the name of the layer.

Drag the cameras to the layer window in the selected arrangement.

To remove a camera from the layer, select the camera and click the Delete button.
Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

vVvyyvyvyy

Deleting a layer

» Select the layer in the overview.

» To search for the layer in the overview, enter the name of the layer in the Search text
box, and then click the magnifying glass icon.

» Click the Delete object icon.

Duplicating a layer

» Select the layer in the overview.

» To search for the layer in the overview, enter the name of the layer in the Search text
box, and then click the magnifying glass icon.

» Click the Duplicate object icon, and enter a name for the duplicated layer.

» Click OK to accept the name.
The new layer is displayed in the overview.

11.2.11 User

The User function on the Administration tab allows you to create and delete user profiles.
In addition, you can configure the connection to an existing Active Directory®
Authorization Manager.
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Creating a new user

Select User on the Administration tab.

Create a new user.

Enter the name and password of the new user.
Click OK to accept the name.

The new user is displayed in the overview.

vVvyyvyy

Configuring a user

General

Password

» Select the user in the overview.
» To search for the user in the overview, enter the name of the user in the Search text
box, and then click the magnifying glass icon.

» Select or deselect the user.
The administrator cannot be deselected.
» If necessary, alter the name of the user.
» Enter a description of the user account.
This can be the name of the user, for example.
» Select the groups to which the user account belongs (see also Groups).
» Apply the set values if you want to make further settings.
» Save the set values to apply the values and conclude input.

» Select User must use a secure password.

If the password does not meet the security requirements (see below), you receive a
message to this effect.

» Select User may change own password to permit the user to change his or her
password.

» Select User must change password regularly and specify the validity period for
the password.

Before the period expires, the user is requested to change the password in order to
be able to continue logging in.

» Select Change user password, and enter a new user password.

If you have selected User must use a secure password, choose a password that

consists of at least eight characters and contains at least one digit, one upper-case

letter and one lower-case letter.

» Enter the user password again.

» To create an additional password should the user forget the first one, select User
needs two passwords and specify a further password, which must adhere to the
same security rules.

» Enter the second password again.

If you forget the administrator's password and haven't added any users to the

administrator group (see Groups), it is no longer possible to access configuration

mode.

» Apply the set values if you want to make further settings.

» Save the set values to apply the values and conclude input.
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Rights options

» Select Limit archive access, and specify the duration of the access period (in
minutes) in order to prevent the user from having continuous access to the archive.

» Apply the set values if you want to make further settings.

» Save the set values to apply the values and conclude input.

Manage user rights

» Select or deselect the rights of the selected user to perform specific actions on the
installed devices and objects.

» Apply the set values if you want to make further settings.

» Save the set values to apply the values and conclude input.

Manage administrative rights

» Select or deselect the rights of the selected user to make changes or settings in the
administration settings.

» Apply the set values if you want to make further settings.

» Save the set values to apply the values and conclude input.

Deleting a user

» Select the user in the overview.

» To search for the user in the overview, enter the name of the user in the Search text
box, and then click the magnifying glass icon.

» Click the Delete object icon.

Duplicating a user

» Select the user in the overview.

» To search for the user in the overview, enter the name of the user in the Search text
box, and then click the magnifying glass icon.

» Click the Duplicate object icon, and enter a name for the duplicated user.

» Click OK to accept the name.
The new user is displayed in the overview.

11.2.12 Groups

The Groups function on the Administration tab allows you to group together and manage
users in groups with identical rights:

Creating a new group

Select Groups on the Administration tab.
Create a new group.

Enter the name for the new group.

Click OK to accept the name.

The new group is displayed in the overview.

vvyyvyy
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Configuring a group

» Select the group in the overview.
» To search for the group in the overview, enter the name of the group in the Search
text box, and then click the magnifying glass icon.

General

Select or deselect the group.

If necessary, alter the name of the group.

Enter a description of the group.

Select a validity period for the group, within which a user belonging to the group
can log in to the system.

The possible periods are specified in the Time Manager.

Specify the validity status to determine the cameras assigned to the group.
All users belonging to this group can thus be prevented from accessing certain
cameras.

Assign the group colors in group lists.

Select the users to be assigned to the group.

Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

v vvyyvyy
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Rights options

» Select Limit archive access, and specify the duration of the access period (in
minutes) in order to prevent the user from having continuous access to the archive.

» Apply the set values if you want to make further settings.

» Save the set values to apply the values and conclude input.

Managing user rights

» Select or deselect the rights of the selected user to perform specific actions on the
installed devices and objects.

» Apply the set values if you want to make further settings.

» Save the set values to apply the values and conclude input.

Managing administrative rights

» Select or deselect the rights of the selected user to make changes or settings in the
administration settings.

» Apply the set values if you want to make further settings.

» Save the set values to apply the values and conclude input.

Deleting a group

» Select the group in the overview.
» To search for the group in the overview, enter the name of the group in the Search
text box, and then click the magnifying glass icon.
» Click the Delete object icon.
Duplicating a group

» Select the group in the overview.
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» To search for the group in the overview, enter the name of the group in the Search
text box, and then click the magnifying glass icon.

» Click the Duplicate object icon, and enter the name for the duplicated group.

» Click OK to accept the name.
The new group is displayed in the overview.

11.2.13 Profiles

The Profiles function on the Administration tab allows you to assign general settings to a
user account or group that apply to the operation of the client. For each user created and
each user group, a profile is automatically created, via which the live layer can be
influenced in surveillance mode.

General

» Select the profile in the overview.

» To search for the profile in the overview, enter the name of the profile in the Search
text box, and then click the magnifying glass icon.

» Activate or deactivate the selected profile.

» Select Confirm termination of the client to display a confirmation on termination of
the client.

» Select Log off user when inactive and specify the timeout (time in minutes) after
which the user is logged out of the system automatically if inactive.

» Specify the timeout (s) for prioritized PTZ actions (in minutes) after which an
installed PTZ camera can no longer be operated.

» Select the layers that can be displayed to the user or group (see Layers).

» Select the patrols that the user or group can select (see Patrols).

» For each user created and each user group, a profile is automatically created, via
which the live layer can be influenced in surveillance mode.

» Apply the set values if you want to make further settings.

» Save the set values to apply the values and conclude input.

Image settings
Video classifications

» Select the quality of the displayed normal and selected video image and the alarm
video image.

Single image (Motion JPEG, MxPEG)

» Specify the frame rates of the displayed normal and selected video image and of
the alarm video image, and then select the display mode.

Streaming (MPEG-4, H.264)

» Specify the frame rates of the displayed normal and selected video image and the
alarm video image.

» Apply the set values if you want to make further settings.

» Save the set values to apply the values and conclude input.
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Video wall module mapping

11.2.14

Video wall module mapping allows you to specify the video wall module in which an alarm
that occurs is displayed.

» Select standard module mapping or select which layer window is to be displayed
on which video wall module.

» If the number of module assignments is insufficient, add to the list by clicking the
Add icon.

» Select the modules you want to delete, and then click the Delete button.

» Apply the set values if you want to make further settings.

» Save the set values to apply the values and conclude input.

Alarms

The Alarms function on the Administration tab allows you to configure and manage alarm
scenarios:

Creating a new alarm scenario

vVvyyvyy

v

Select Alarms on the Administration tab.

Create a new alarm scenario.

Enter the name for the new alarm scenario.

If you want to configure the new alarm scenario using the configuration wizard, select
Wizard in the dialog box.

Click OK to accept the name.

The new alarm scenario is displayed in the overview.

Configuring an alarm scenario

General

>
| 2

vvyyvyy

v

vy

Select the alarm scenario in the alarm overview.
To search for the alarm scenario in the overview, enter the name of the scenario in
the Search text box, and then click the magnifying glass icon.

Select or deselect the alarm scenario.

If necessary, alter the name of the alarm.

Enter a description.

Use the slider to assign the alarm a priority.

The meaning of the priority level is displayed.

Select the validity period for the alarm.

The possible periods are specified in the Time Manager.

Select the color in the alarm list.

Select the settings for low-priority alarms.
Terminate alarm on clients when terminated on server: The alarm is terminated on
all of the clients involved and removed from the alarm list.
Start new alarm on clients if another low-priority alarm is active: A low-priority
alarm displaces another active low-priority alarm. In other words, the current alarm is
put aside, and the new alarm is displayed.
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Start

End

| 2
>

Visualization

| 2

>
| 2

>
>

Do not close layers automatically at end of alarm: Prevents the layer from being
automatically closed at the end of the alarm.

Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

Use the Select button to select the events that trigger the alarm.
The hardware and event are displayed.

Use the Select button to select the buttons that trigger the alarm.
The hardware and button are displayed.

Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

Specify the maximum server alarm duration (in seconds) to specify how long the
alarm is to be recorded for.

Use the Select button to select the events that terminate the alarm.

The hardware and event are displayed.

Use the Select button to select the buttons that terminate the alarm.

The hardware and button are displayed.

Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

Select the cameras and layers to be displayed in the various windows in surveillance
mode.

Select normal mode or full-image mode for Window mode.

Select the window to display the camera or layer in the main window or in one of the
secondary windows.

Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

Persons involved

Server

>
>

Select the profiles of the users or groups allowed to see the alarm.

Enter a text for alarms with a medium or high priority level in the message window.
This text is displayed in the message window.

Select Play signal tone, and then select whether the signal tone is to be played
when the alarm is activated or triggered.

Select Run external program if a program is to be started at the same time as the
alarm.

Use the Select button to select which document is to be opened by the program.
Enter any parameters required by the program.

A document can be opened using the selected program, for example.

Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

Specify the pre-alarm duration for camera recordings (up to a maximum of 3600
seconds) to record a period before the alarm is triggered.
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>
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Configuration mode

Select Use separate frame rate (fps) for camera recordings, and enter the
required frame rate.

Use the Select button to select the actions at the start of an alarm.

The selected actions are displayed.

Use the Select button to select the actions at the end of an alarm.

The selected actions are displayed.

Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

In an alarm scenario, in addition to the alarm message, it is also possible to send a
standard email or specify a data export to an FTP server.

>
| 2

|

Enter the subject and text for the email message.

Select the recipients to receive the email at the start and end of the alarm.

You can specify the email addresses in the Alarm addresses section of the system
settings.

Select the cameras whose data at the end of the alarm is to be attached to the
email, and specify the data format.

Note that the email attachments can exceed the permissible size of the email.

|

>
| 2

Select the cameras whose data is to be stored on an FTP server when there is a
large volume of data, and specify the data format.

The FTP server is specified in the SeeTec VA Administration tool.

Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

Deleting an alarm scenario

| 2
>

| 2

Select the alarm scenario in the overview.

To search for the alarm scenario in the overview, enter the name of the scenario in
the Search text box, and then click the magnifying glass icon.

Click the Delete object icon.

Duplicating an alarm scenario

11.2.15

» Select the alarm scenario in the overview.

» To search for the alarm scenario in the overview, enter the name of the scenario in
the Search text box, and then click the magnifying glass icon.

» Click the Duplicate object icon, and enter a name for the duplicated alarm scenario.

» If you want to configure the new alarm scenario using the configuration wizard, select
Wizard in the dialog box.

» Click OK to accept the name.
The new alarm scenario is displayed in the overview.

Patrols

The Patrols function on the Administration tab allows you to configure multiple
cameras, set positions, maps and layers one after the other for a user-definable time. It is
also possible to open or close digital outputs in a patrol and create checkpoints.
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Creating a new patrol

vVvyyvyy

Select Patrols on the Administration tab.
Create a new patrol.

Enter the name for the new patrol.

Click OK to accept the name.

The new patrol is displayed in the overview.

Configuring a patrol

>
>
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| 2

Select the patrol in the overview.

To search for the patrol in the overview, enter the name of the patrol in the Search
text box, and then click the magnifying glass icon.

If necessary, alter the name of the patrol.

Select the default pause (in seconds) to set the duration for which a layer is to be
displayed.

Click New group to group together the objects of the patrol.

Specify the name of the group, and then click OK.

Drag the objects from the left-hand column to Patrol positions or the group.

If necessary, insert a new pause and specify its duration.

Insert a new checkpoint and give it a name.

Select the object in Patrol positions, and then move the object up or down in the list
by clicking the Up or Down button.

Select the object in Patrol positions, and then click the Edit button to adjust the
object's settings.

Select the object in Patrol positions, and then click the Delete button to delete it.

Deleting a patrol

|
>

| 2

Select the patrol in the overview.

To search for the patrol in the overview, enter the name of the patrol in the Search
text box, and then click the magnifying glass icon.

Click the Delete object icon.

Duplicating a patrol

11.2.16

» Select the patrol in the overview.
» To search for the patrol in the overview, enter the name of the patrol in the Search
text box, and then click the magnifying glass icon.
» Click the Duplicate object icon, and then enter a name for the duplicated patrol.
» Click OK to accept the name.
The new patrol is displayed in the overview.
Sequences

The Sequences function on the Administration tab allows you to create sequences in
which multiple set positions are approached one after the other and/or actions are
triggered.
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Creating a new sequence

vVvyyvyy

Select Sequences on the Administration tab.
Create a new sequence.

Enter the name for the new sequence.

Click OK to accept the name.

The new sequence is displayed in the overview.

Configuring a sequence

| 2
>

General

Actions

Select the sequence in the overview.
To search for the sequence in the overview, enter the name of the sequence in the
Search text box, and then click the magnifying glass icon.

Select the sequence and, if necessary, alter the name.

Use the Points in time and Time periods buttons to specify as of when or within
which period the sequence is to run.

Select one or more entries, and then click the Edit selected entries button to edit
the entries one after the other.

Select one or more entries, and then click the Delete selected entries button to
delete the entries.

Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

Create a new group and give it a name.

Drag one or more cameras or actions to the group, and then specify the dead time
(in seconds) to specify the interval within which no new signal is displayed.

Select a group, and then use the New pause button to adjust the pause (in seconds)
to specify how long the camera or layer or map is displayed.

Select a group or an entry, and use the Up or Down button to move it up or down in
the list.

Select a group or pause, and then click the Edit button to edit the name of the group
or the duration of the pause.

Select a group or an entry, and then click the Delete button to delete the group or
entry.

Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

Deleting a sequence

>
| 2

|

Select the sequence in the overview.

To search for the sequence in the overview, enter the name of the sequence in the
Search text box, and then click the magnifying glass icon.

Click the Delete object icon.

Duplicating a sequence

|

Select the sequence in the overview.
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» To search for the sequence in the overview, enter the name of the sequence in the
Search text box, and then click the magnifying glass icon.

» Click the Duplicate object icon, and then enter the name for the duplicated
sequence.

» Click OK to accept the name.
The new sequence is displayed in the overview.

11.2.17 Server

The Server function on the Administration tab allows you to configure the server services.

CoreService

» If necessary, alter the name, network address and port number of the server.

» If necessary, alter the network address and port number of the master server.

» Click the Remove from the system button to remove the core server from the
system configuration.

» Apply the set values if you want to make further settings.

» Save the set values to apply the values and conclude input.

Global OCR settings

» Select the server on which the LPR service is to run.
» Select Enable automatic master data entry for unknown license plates.
License plates are automatically added to the license plate database.
Adjust the font color and background in the display of the license plate.
Select XML export to export the license plate data as an XML file.
Select Enable automatic master data entry for license plates that are no longer
valid.
» Create up to 10 additional fields in the master data fields.
These are displayed when you add or edit a license plate.
» Select Required field and/or Search field to specify that an entry must be made in
this field (required field) and/or it is possible to search for this data (search field).
» Apply the set values if you want to make further settings.
» Save the set values to apply the values and conclude input.

vvyy

Device Manager
General

» If necessary, alter the name of the image data server.
» Select the failover server.
In the event of the failure of the image data server, all connected devices are
transferred to the failover server.
Note that the failover server must have sufficient capacity to take over the devices.
Specify the time of the data aging search.
Select Accesses to video sources to exclude these events from automatic deletion.
Select the period after which the events are automatically deleted.
Click the Display statistics button to display the events.

vVvyyvyy
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>
| 2
>

Configuration mode

Click the Remove from the system button to remove the Device Manager server
from the system configuration.

Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

If necessary, alter the port for SIP messages.
Apply the set values if you want to make further settings.
Save the set values to apply the values and conclude input.

Image data export

>
>
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vvyy

Select the automatic export of the image data.

Create the export path for the automatic storage of the image data, or click the
Select path button to select the folder directly in Windows Explorer.

Click the Check path button to check the availability of the specified folder.
Specify the time of the export.

Select Export image data of the last 24 hours to add current events to the export.
Specify a password, with which the image data is encrypted.

Create the temporary export folder on the server for the manual storage of the
image data, or click the Select path button to select the folder directly in Windows
Explorer.

Specify a password, with which the image data is encrypted.

Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

11.2.18 System

The System function on the Administration tab allows you, for example, to configure
and manage system-wide settings for the network, automatic backups as well as
communication settings and event management settings.

Backup

vvyy

vvyyvyy

Select Use automatic backup to schedule automatic backups.

Select the time and start time of the backup.

If necessary, edit the storage path for data backup or click the Select button to
select the folder directly in Windows Explorer.

Select Delete old data to delete existing backups before the data is backed up.
Click the Perform backup button to carry out the data backup immediately.
Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

Company calendar

In the company calendar you specify the days to be handled in time templates separately
from normal weekdays (e.g. public holidays or non-working days). Time templates are
created in the Time Manager. They allow the precise specification of recording periods or
times in which alarm scenarios are started.
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SMTP server
>

>
>
| 2

Hold down the CTRL key to select the days of the month to be added to the time
template.

Click the Decade button to select the year.

Click the Year button to select the month.

Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

Select the SMTP server to specify an outgoing mail server via which the emails are
to be sent.

Specify the network address of the SMTP server and the port number.

Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

Email Manager

>
| 2

SNMP server

vyVvyVvyyvyy

NAT list

>
| 2

Click the Add new email list button, and then specify the name of the new list.
Click OK to confirm.

The new list is displayed.

To remove the list, select it and click the Delete all email lists marked for deletion
button.

Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

Select the SNMP server to set the network management protocol.
Specify the IDs of the SNMP server and the port numbers.

To check the settings, click the Send SNMP test message button.
Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

Click the Add new NAT entry button, and then specify the internal and public
address.

Click OK to confirm.

The new list is displayed.

To remove the list, select it and then click the Delete all email lists marked for
deletion button.

Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

Event Manager

In the Event Manager you tidy up the event database.

General

|

Select Use automatic deletion, and then select the period after which the event
database is to be deleted.
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To tidy up the database manually, select Delete only events that are older than,
and then specify the period.

Click the Delete events button to delete the events in the selected period from the
database.

Specify the time for the daily report on the system events.

Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

Error/warning/info

| 2
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Select all of the events in the list (SNMP events), and then click the Edit selected
objects button.

Select the actions to be carried out with the events.

Click the Back to overview button to go back to the list of events.

Apply the set values if you want to make further settings.

Save the set values to apply the values and conclude input.

Entity numbers

| 2
>

Apply the set values if you want to make further settings.
Save the set values to apply the values and conclude input.

Video classification

| 2

| 2

>

Click the Add new video classification button, and then specify the name of the
video classification.

Click OK to confirm.

The new video classification is displayed in the list.

Select the video classifications you want to delete, and then click the Delete video
classifications marked for deletion button.

The standard video classifications ("Superior quality”, "High quality”, "Balanced"
and "Web") cannot be deleted; they can only be renamed.
» Apply the set values if you want to make further settings.

|

Save the set values to apply the values and conclude input.

73






12

Index

2008 R2 Standard ..........cccceeervneen. 11
2008 Standard.........ccccocveiieienneenns 11
32-Dit e 11
32-bit/B4-bit .......eeveiiiiiiiiie 11
3rdPartyToolS ........cooiiiiiiieeeees 11
485 port of the video encoder is
required for each redirection.....53
B4-Dit ..o 11
A short TTL results.........cccvveennnnen. 53
above........coc 53
Accordingly........ccccceeiiiiiiiiiie, 53
action can be started once
notification is received............... 53
Active Directory .........cceevvveeeen. 23, 69
exXiSting ..o 69
Add ..o 34,73, 82
Add SEeTEC ...covvvveeiiiiieeiee e, 26
Add WINAOW .......cocvviiiiirnieiieeeeeen 31

Administration 52, 61, 62, 63, 64, 65,
66, 67, 68, 69, 71, 73, 74, 78, 79,
80, 82

administrator's.................... 23, 26, 69
Advanced .........coceeeiniiiienieee, 23
after which.......cccociii 53
after which the client has to............ 53

after which the recordings are to be
compressed and released from

the audio track.........cccceevvvneeenne 53
alarm.....cocoeeeeeieeeee, 29, 37,74
alarm displaces.........ccccceeviiieeennnn 74
alarm duration...........cocevvvverieennnen. 53
alarm duration has............cccceeeenee. 53
Alarm list.....cooooveiiiii e, 37
alarm scenario ..........ccceeeeviiieeennnn 53

All differences to the stored reference
image are masked.................. 53

All of the image storage settings ... 53

All saved recordings of the camera

are deleted...........ccocveevvinneenn 53
AIWAYS ..o 53
analyze .........ccocc e, 49
analyzed ........cccceviiiiiiiie 7
and archive ..........cccccoveiicnene, 53
and eNter ........occceeeviieeenee e 53

(072 10 1 [=] = VN 53
and how ........cccceeeeiiiiiiiiiiiceee 53
and image quality ........c.coccveeennne. 53

and the camera image is displayed53

and the network address or host... 53

and then change the port .............. 53
and then click Edit ............c.cceenee 53
and then click IP setup .................. 53

and then click the magnifying glass
and then drag the shape over the

cameraimage.....ccccceeeeevrevvnnnnn 53

and then enter the title................... 53

75



Cayuga Manual

and then load ...........ccccoveveeeiiiinns 53 C
and then specify the port............ 53 Call URL oo 64
and thUS .......................................... 53 Camera ____________________________________ 40, 53
and t|me .......................................... 53 camera are always dlsplayed ........ 53
and/OI’ ............................................. 80 Camera |mage Controller _______________ 38
API .................................................. 53 Camera motlon detectlon .............. 53
Apply .............................................. 53 Camera OverV|eW ___________________________ 40
ArChIVG ........................................... 45 Camera pos|t|ons ........................... 53
AI’Chlve mOde ................................. 45 camera ur"t and _____________________________ 53
are COﬂfIgured here ........................ 53 CameraManagement ..................... 29
are to be carried ..., 53 CAMENAS ... 53
are to be d|Sp|ayed ......................... 53 Camera's Storage area on the hard
areas of the camera image ............ 53 AISK wevneiiiiiiiies 53
ask for the correct assignment of the Canceling.......cccvevviiieeiiiiee e 40
API version to the camera capture modes.............cocoeueeeeeunnn. 53
firmware ......coooooveeiiiiieieeeeees 53

Cayuga ...5, 7,11, 13, 15, 17, 19, 23,
AUdIORTP .., 29 25 26
Audio Settings.......ccccevvveeeiniiineenn 53 INSEAIING «eevv e 23
authorization........c.ocovveveeevienenceeneens 53 cD 32
Authorization Manager ................... 69 change the camera ID and adapt the
AV i 45 ID of the associated camera..... 53
AXIS TB312 ..o 29 change the server for managing the
AXIS T83LX oo 29 GBVICES vvvsvvsvssvrsnsvn >3

(04 0 T- 1 ¢ ST 26

B

(O [0 S 80
BaCK ..coooveiiiiie e, 40, 82

Choose Activate .......cccoooevveererennnnn. 33
Background.........ccccceeiiiiiiiiiineeen 66

Choose Add SeeTecC .....ccceeeeeeeeens 26
Balanced ..........ccooeviviiiiiiiiieeeeen, 82

Choose Add window...................... 31
bandwidth connection .................... 53

Choose Change........cccccceeeeviennnene 26
base profile during installation ....... 53

Choose Client ........ccceeeevivveeeeinnnnn. 26
behaVIOr.......ccovieee e, 34

Choose CoUNt........cceevvevvveieeeeennenns 26
behavioral.........cccooovvivieiiiiiiiiiien. 11

Choose Disconnect SeeTec.......... 26
black and White .............ccevvvvveennnen. 53

Choose Display ......ccccccvveeeevicnnnen, 33
BUfEN o 53

Choose Multiple...........cccovevveeenne 32
0101 (0 o IS 53, 64

ChooSe Start.....ccoooeeevveevvviieieieeeneens 34

76



Choose SWItCh ........cccovcvviinienneens 26
Choose TidY ....coovviviiiiiieeeeiieee, 26
Choose WHte ......ccocvveniieriiiennees 32
classifications ...........cccceeviiveeennnnn. 82

click Delete history and then Yes...53

Click NEW ....ooeiiiiiieiiiiiie e 53
Click OK to accept the name.......... 53
Click OK to confirm your entries.....53
click the Browser button.................. 53
Click the Delete object ................... 53
Click the Duplicate object............... 53
Click the New .........ccooveiviiieeininnnn, 53

Click the number of the preset
position to be moved to with the

new camera setting................... 53
Client configuration .............cc.c...... 29
ClIENTS .ooviieceee 53
COION i 62, 74, 80
color and shape of the mask.......... 53
COIOIS i 71
CompPany ......couuviiiiieeieri e 51
Configuration..........cccceevvcvveeenns 37,51
Configuration Mode................... 29,51

configuration of the network address
of the camera depends on the

manufacturer's installation ........ 53
configuration settings .........c.cc.ceuuus 40
Configuring .......ceeevvieeeiiiiieeeieen, 53
connected control unit.................... 53
connected PTZ control unit............ 53
CONSLANt OF...coeeeiiieeeeeeeeeeee 53
continuous recording is started ...... 53
CoNtrol......ceeeviieeeeiiiieee e 37,40
control bar .......ccccoeviiiiis 35
Control Panel ........ccccevevninenn. 18, 19

Index

control unit to give the user the
option of controlling the camera53

cordless phone ..............coeeeeeee. 53
COreSerVviCe....couvviiieiieiiee e 80
CPU ., 11
Create ..o 51, 53
Create subfolders ...........ccccceevnnee. 32
Creating .....ccoovveeeiiieeeeeee 53
CSV ittt 49
CTRLKEY...ooiiiiiiiiiiieiciecc 82
D-76661 Philippsburg..........cc..oe...... 1
data/time ........ccooeeiiiieee e, 49
Decade .......cocvevveeriieiee e 82
DECT ..ot 53

Delete .29, 45, 51, 61, 62, 63, 64, 65,
66, 67, 68, 69, 71, 73, 74, 78, 79,
82

Deleting .....cevveeeiiiiiiiieieeeeeie, 53
depending ON.........cccccvvvveveeeeeiiinns 25

Depending on the camera model

Depending on the setting selected 53

Depending on the user authorizations

.................................................. 53
depends on the camera................. 53
DeseleCt DO ......ccovvveeeiiiiieeiiiieee 29
Deselect Enforce ........cccccocvvevnennne. 23
Device Manager ...........ccceeenee. 61, 80
Device Manager server ................. 53
differences from.........ccccccovverenen. 53
Digital iNputS.......ccvvvvveeeeiiiiieeenn, 53
Digital OUtpuUtS.........eeveiiiieeeiiiieee 53
DIr€CtX ...vvveiieeiiee e 11
Disconnect SeeTecC ........ccccevuvveeenne 26

77



Cayuga Manual

(D1 o] 1= YR 80 Active Directory ...........c.coeeene.. 69
Distributed server installation.......... 15 SeeTEeC i 29
Double-click Setup ............. 17,18, 19 Export 26. 32. 45
DOWN .o 78,79 Extras 32
Duplicate .. 61, 62, 63, 64, 65, 66, 67, Extras menu 32
68, 69, 71, 74, 78, 79
F

Duplicating........ccccvvveeeeeeiniiiiieeen. 53
DVDS .o 32 ROV oo 17,80

FAQS...ii i 34

E Q

Features ........cccoooiiiiiiiiiiiiee 18, 19
e.g34

few MINULES .......occvverieiiceee 53
€.0: coeerieeennn 7,11, 52, 53, 65, 66, 82

File menu ... 26
Edit ..o 51, 78, 79, 82

_ ) Finish ..., 13,15, 17

effect on alarm recording that is _

GG vvoveeeeeeeeeeeeeeeeeeene, 53 fiSheYe ..ooeeiiii 53
Email Manager ............ccocvveureninnn. 82 for alarm recording to record......... 53
EMallS......coviviieiceeeeeee e 82 forexample ..., 53
Enter the host........ccccocoiviiiiinne 53 for starting image recording........... 53
Enter the name............c.cccevevennenen. 53 for the cameraimage.................... 53
Enter the name for the new camera for the export ... 53

.................................................. 53 for the tlme 53
enter the name of the camera........ 53 fOr this ..., 80
Enter the name of the new preset fps53, 74

position and click OK ................ 53 .

frame rates and resolutions........... 53
Enter the network address and port _
from viasys .....cccoccveeiiiiiieeee 53

.................................................. 53
ENEEIPIISE vovvvrreoeeoeoeeoeeooeoeeeeeooe 11 FTP e 74
EXTOrWAIING/INTO ovvvvrvovoooesrooero 82 Fullscreen ........ccoocveeeiiiieeniciieeee 38
etc11, 26, 29, 34, 51 functign a-nd specify how long the -

object is to be masked for after it
etup .......................................... 13, 15 COMEBS tO et 53
EVENt ..o 49 Functional Overview _________________________ 7
Event analysis .........ccccovveeeeiiineeens 49 G
Event Manager..........cccccvvvvvvvinnnnnn. 82 GB 11
EXIStING .o 29, 69 General 53
German.......ccoo 1
GHZ.oooiee 11

78



Gigabit Ethernet .......cccccceevvinvnnnen. 11
Global OCR......coovvviiveiiiiiee e, 80
GrOUPS. .. 71

Help oo 26, 34
helpdesK......cccceeeviiciiiiiee e, 3
HIGN e 82
higher network load........................ 53
Home Premium ..........ccccceevviieeennne 11
i.e.23
ICON .ttt 53
IDS oo 82
If 53
if applicable ..........ccccoceveeiiiiinn. 53
if NECeSSary ......oocuvvieeeieeeiieeee. 53
if required .........ooecvviveeee e 53
If the API version cannot be retained
.................................................. 53
If the camera.......ccccevvieeeniiieennen, 53

If the camera does not have its own

PTZ control unit............ccuuvveneeee. 53
If the camera has .........ccccceeveeeeen. 53
if the camera supports.................... 53

If there is not enough storage space

.................................................. 53
if there is tampering with the camera

or the video signal is ................. 53
if you are configuring...........cccee..... 53
Ifyouusethe.......ccooviienniiennn, 53

If you want to adjust the IP address
of the camera........cccccvvvvvvvvnnnns 53

If you want to configure the new
camera using the configuration
WIZard......cccveeeeieeeiiiiiieeeeee e 53

image analysis is to be carried....... 53

Index

Image data export...........cccevvvvennns 53

image data from being overwritten 53

image SeqUENCES .....cceeeveeeeeeeeeeennn, 53
Image storage..........cccevvveveverenennnes 53
1 = Vo T 53
INFINILY o, 5
INFO.ceeiiiee e 33
INfOMENU....ooiiiiiiiie 33
INfrastruCtures........ccceevvveeeeiineeeens 5

inputs and specify uniqgue names for
Name for CLOSED and Name for

OPEN ..ot 53
INR .o 33
Installation ..........cccceeviiieiiiiiinnens 11
installation and...........ccccoeeiiieeennnns 5
INStalling......cooovveeeiiiiieiiece e 23

CayUga . ovieeeiiiiiic e 23
INtEl ..o 11
Intel DualCore.........cccoovvveeiiieecenns 11
Intelligent Video GmbH.................. 53
Internet ........occcvveeeeeenn 7,23, 33,64
Internet SecuUrity .........cceccvveeveeennn. 11
INtranet........coooveeeiiieee e 64, 65
INtroduction............ccccovveinnienieneenn 5

IP 15, 26, 29, 40, 61

IP127.0.0.1 cceeeiiiieeiiieee, 13,15
IPcamera........ccccvvvvciiiiieecieiiinnnnn, 53
is identified automatically............... 53

is to be requested from the camera53

it can take several seconds to switch
from standard to alarm recording

79



Cayuga Manual

K method of the Scrambling function
allows you to mask moving
(=TT o PP PPPPNt 29 objects or PEopIe .......ovvvvvvee.... 53
Klicken Sie auf Programm method to mask fixed 53
deinstallieren.......cccoocoovvvvvvvnnnnnn. 18
(0011 11
L
mode bar .........oceeiiiiiiiee 34
LAYEIS. . iieiieeeeieeeeeieeeeeieieeeeeeeeeeeeeeenes 68 )
1Y/ [o o 1 2 19
Legal notice......cccvvveeeeeeiiciiiieeeeeen 1 )
Motion JPEG ......cccooovviviiiieeii 73
[ENS ... 53 ] ]
moving object ........cccoveveeeiiiiiin, 53
LICENSE ..vvvveve e 62 ] )
Moving objects.........ccccoeiiniinnens 53
License plate groups........ccccceeeeenn. 62
MPEG .....coooeevieeieiieeie, 11, 29, 53
localhost .........ooevvveeeeiiiiiiiiiiin, 13, 15
MPEG-4 ..o 73
Location........ccceveeeeeeeeieeiieieeeeeeeeee, 51 o
MPEG-4/H.264 streaming is
Login ........................................... 7,23 manufacturer .......coveeeieiieii, 53
[OQOULS.....oeeiiiiiieeiiieeeee e 7 ms29, 53
LOOP .o, 40 U e 26
O e 53 Multi Solution Platform.................... 5
LPR 26, 31, 52, 62, 80 MUIICOT® .o 7
M MUItIPIE VB .. 11
Main window .........cooeeevvneeeeennn. 31, 37 MXPEG ..., 73
MaKE.....ceveeeeeiiiieieeeee e 53 N
Make selections for Action.............. 53 name of the camera..................... 53
MapS ............................................... 66 name of the network camera......... 53
MASK .. 53 name or IP address of the camera 53
MaSKING ......cocvriiiiniiii, 53 NAT ettt 82
Masking duration............................ 53 N S T 82
MASKINGS ..eeeiiiiieeeiiiie e 53 Native Client .......oooreeeo. 11, 13, 15
MaXimUM ..., 29 Native client installation ................. 15
maximum of 3600 seconds............ 53 Native-ClIent ..........ocoeveeveeeeeeeeeennn 11
maximum of 4096 kbpS .................. 53 network camera are a|Ways
MaXiMUM POSt........ccevvreererrereennn. 53 subdivided into video server
settings and camera settings.... 53
MB . 11
Network cameras consist of .......... 53
MDS ..o, 13, 15
NEW....oevvveieeee e, 26, 78,79
MEANS Of..cieveiieiee e 53
NEW CAMEIA...uuivniiriiiniiiieeeiieennenanas 53

80



NEeW SEETEC........ccvvveriieeeeirieeees 26
new video stream ...........ccceeevvvneen. 53
Next.....cccooevvnns 13, 15, 17, 18, 19, 40
NON oot 82
NOIMON....oeviiiiiii 11
Norton Firewall ............coceeiviinenns 11
not mounted upright ............cc.veee.. 53
(0] (0 ]=)'( 0 [0 ] ¢ AR 53

Note the associated documentation
of the installation ....................... 53

notification is to be sent to the server

automatically .........ccccceeeiiinnnne 53
NUMDET ..o 53
NUMDBEr if ..o 53
number of the multicast server....... 53
of the camera ..........ccocvevviiiiinnnn. 53
of the camera control ..................... 53
of the connection...........cc.cccceeenee. 53

of the image quality and image

storage settings.......ccccceeeeeennnnee 53
of the images of the recordings......53
of the recording is to be limited ...... 53
of the recordings .......ccccceeveeevenneee, 53

of the Scrambling function masks..53

of the video stream.........ccccoeeeeere 53
Of theM .. 53
(@] 11107 T 53

OK 13, 15, 17, 26, 33, 40, 45, 51, 61,
62, 63, 64, 65, 66, 67, 68, 69, 71,
74,78, 79, 82

on the Administration tab ............... 53
Optional uninstallation.............. 18, 19
Or httpS .o, 53
Other ..o, 61

Index

Other hardware..........cccccooevveeennee 61
OULGOING ...evveeeeiieie e 29
output is opened or closed ............ 53

outputs and specify uniqgue names for
Name for CLOSED and Name for

OPEN ...ttt 53
Participant...........ccccvveeeeeiiiiiieeen, 29
Patrol ......c.cooovviieiiiiiiiiciieeees 40, 78
Pause.......cccoiiveeiiiiie s 40, 46
PBX.eiiiiiiiiiiiiiiiii 29
PCS i 31
Pentium .......ccoceviiiieiiiie e 11
percentage of the.........ccccceeeenen 53
Perform ... 64, 82

period after the alarm is triggered . 53

period before the alarm is triggered

.................................................. 53
PEISON .. 53
PlAY ..o, 40, 46
POINES....eiiieeiiiee e 79
possible quality ..........cccceeevvinvvnnnn. 53
Pre. et 53,74
preset position ........ccccceeeevevinvnnnnn. 53
PNt oo 26
prioritized PTZ .....cccccveveeiiiiiee. 73
Privacy masking settings................ 53
Professional.........c.ccccoovviniiennennn 11
Profiles......ccoooeiiiie 73
profiles for the transmission of image

data.. oo 53
Program Files .....ccccccveeeiviciiiieennn, 19
Programs.........cccceevvvvveeeinnnnnns 18, 19
PTZ. s 37, 38, 40, 73
PTZ cameraor........cccccoevvvvnnneennn. 53

81



Cayuga Manual

R

RAM ..o 11
recording available during this period
.................................................. 53
reference image .........ccccceeevnnnnneen. 53
Registration ........ccccccceevvviiiiieenenennn 29
FEMAINING...cceivieeeeiiiiee e 19
YTl =T o 19
Remember........cccooovviiiiiinieee 23
Remove........ccoovciiieeneennnn 19, 32, 80
Repair....ccceeiiiiiieeee e 19
repair or uninstallation.................... 19
ROMS ..ottt 32

RS53
RUN...ooii e 64

S

SL00 i 5
SL000 ...t 5
Y0100 GRS 5
1310 ) GO RSP URP 5

Search 40, 49, 61, 62, 63, 64, 65, 66,
67,68, 69, 71, 73,74, 78, 79, 80

LY=T070] 016 F 3 53

EXISTING «eeeeiiiei e 29
remaining .......coceevviiiiieiiiinn... 19
SEETEC AG....ccieeiieeee e 1
SeeTec AutoUpdater...................... 11
SeeTec Cayuga ................... 5, 15, 23
SeeTec Cayuga Infinity .................... 5
SeeTec Cayuga S100..................... 5
SeeTec Cayuga S1000.................... 5

SeeTec Cayuga S50 ......cccceeevennnnnne 5
SeeTec CoreServer........cccccovvunee. 15
SeeTeC DVD......cccoocvveiicieiee, 11
SeeTec Enterprise Edition............... 5
SeeTeC MUlti....ccceeriiiiiie e 26
SeeTeC S50......ccovvvcviiieiiiiiiiiie, 5
SeeTec Service Manager.............. 15
SeeTec VA Administration tool...... 74
select .......cu.... 32, 53, 64, 74, 80, 82
Select. ..o, 13, 15,17, 18
Select ACCESSES ......ccvvvveverreenenen, 80
Select Add .......cevveeiiiiiiie 37
Select Alarms .......cccoevevcevinieennen, 74

Select automatic deletion of the
standard recordings or alarm

recordings after ...........cccceeenee. 53
Select Black and white .................. 53
Select button............ccccevvineeen. 64, 74
Select Camera.........cocevvveveeeennnnn. 53
Select Change.........ccccccceeeenn. 26, 69
Select CloSe ....occvvevvieiiec e, 37
Select Confirm .........ccoceevviiieinnnn. 73
Select Control camera................... 53
Select Create ZIP file..........ccco... 53
Select Delete .........cocvevveennenne 29, 82
Select Display ..........cccceevvveeeenninnen. 66
Select Display buffer and specify the

required Size.......cccccceeeeeiiiinnnee 53
Select Display title if you want....... 53
Select Download...........c.cceveennnee. 33
Select Enable ..........ccccoovvviiiiinnne 80
Select EXPOrt .......coccovveiviiiieininnnn, 80
Select Gateway ........cccceveeeeviennnen, 53
Select GroupsS ......coccvvevevnieeeeininenen 71
Select Hardware ............cccevveennen. 61

82



Select Invert PTZ control................ 53
Select ISearch..........ccccevviiiieinnen. 38
Select KEEP..ovvvvvvviviieeee e, 31
Select Layers ......oooeviieeiineeninins 68
Select LiCense.......cccccvevvevinveenineens 62
Select Limit.......ccceevivvveeiniieeenns 69, 71
SY=11=Tod o To [P 23,73
Select Maps ..ocoveeeviviiiiieeie e 66
Select Mirror.......cocvcvveveeiiieennens 66
Select multicast..........ccccocvveeernnen. 53
Select OffiCe.....cccveviiiiiiiieceiee 53
Select Open ......coovvviiieieeeeiii 37
Select or deselect the camera........ 53
Select Pan.......cccccvviivviiniiicin, 53
Select Patrols ..........cocevvvvevieeiinnns 78
Select Personalize ...........cccccoeuveee. 33
Select Play ....ccoeeevvvviviieieeee e, 74
Select privacy masking .................. 53
SeleCt PTZ oo 53
Select Reduce frame............cc........ 53
Select Reduce resolution ............... 53
Select Remember ........cccccvvevineenn. 23
Select Required........ccccceeveevvinnnnnn. 80
SeleCt RUN......ceeeeviiiiiiicc, 74
Select SeeTeC.....cccvvvrveerineenns 18, 19
Select SeqUENCES .......cceeevevrurinnnn. 79
Select Start........cocevvveniieiiiennees 34
Select StOP ...ovveveeiiiiieee e 29
Select SUPPreSS....ccvvvveveeeeeiiivinnen. 29
Selectthe ..., 53
Select the camera..........ccccocveeenen. 53
Select the camera capture.............. 53
Select the camera position............. 53

Index

select the camera's manufacturer for

Available IP installers................ 53
Select the capture......cccccceeeeennneee 53
Select the desired number of motion

detection windows .................... 53
Select the Device Manager ........... 53
Select the manufacturer and ......... 53

select the manufacturer of the

(02211 0 [T = F U 53
Select the maximum resolution ..... 53
selectthe name .........ccccceeeveeeeenn 53
Select the protocol............ccoeueee 53
Select the recording period ........... 53
Select the Scrambling.................... 53

Select the Static objects function and
select the shape of the area to be

hidden.........cooeiiiieie, 53
Select the Static objects or

Scrambling.......ccocccviiiiiiiiininnn, 53
Select the time limit and enter the

maximum storage duration....... 53
Select the transmission ................. 53

Select the transmission of audio ... 53

Select the transparency................. 53
Select the video stream................. 53
Select Time Manager .................... 63
Select Use ......ccccvvevveennnnn. 29, 74, 82
Select Use NAT .....occvvveviiiieeiiien. 23
Select USer.....cocovvviveviiiiieecinns 69
Select VIideo .......cccocvvvveviiieieninnen. 67
SeleCt VOIP ... 40
Select Web ........ooovviiiiiiiiii, 65

Select whether alarm recordings... 53

Select whether standard recordings

83



Cayuga Manual

Select XML ...oovvvieirieiiiiicines 62, 80
selection for Action...........cccceeeeee. 53
selection for Bandwidth control ...... 53
Send SNMP ..o 82
Sensitive areas or movements....... 53
SENSItiVILY ..ovveeeieeeiiiiieeee e 53
separately for standard and alarm
recording ......cocoveeeeeeeeniiiieeeenn 53
separately for the video settings and
SINGIE ... 53
SEQUENCES ...ovveiieieeeveeiiiii e 79
SeIVer....oocciiiiiieiee 11, 13, 80
servers have been installed for
storing the image data .............. 53
Sl 45
SEtNGS ..o 53
Showing/hiding........cccooevveeiiiinnnee, 35
signal is analyzed again................. 53
SIgNAlS ... 53
single masking or Delete................ 53
SIP 29, 80
SMTP o, 82
SNMP . 82
Special case.......cccoocvveveiiiiieeniinenn, 53
SPECIfiC..cciiiiieie e, 29
specific and is therefore not
supported ......oeeeviviiiiiieeee e, 53
specific events can be used........... 53
specific parameters.........ccccceeeeenns 53
specific timespan..........cccoccveveenne. 53
SPECIY. i, 53
Specify for Timeout ...........cccceuveeee. 53
Specify the....ccoovvici e, 53
Specify the frame ..........ccoceeevieen, 53

Specify the interval for the dead time

Specify the maximum bandwidth to
be made available between the

camera and SeeTec server ...... 53
Specify the maximum frame.......... 53
Specify the maximum length ......... 53
Specify the PTZ sensitivity ............ 53
Specify the recording period to be

eXPOorted.......coveevviieeeerniiee e, 53
Specify the time limit...................... 53
Specify the validity period.............. 53
Specify whether............................. 53

Specify whether standard recordings
and alarm recordings are to be
exported automatically ............. 53

Specify whether the camera name

and time of recording are ......... 53
Specify whether the length ............ 53
SPIt e, 32
standard and alarm recordings are

configured separately................ 53
Standard installation...................... 13

Standard recording data aging or

Alarm recording data aging ...... 53
S | o U 32, 34,64
Start MeNU .....ooeeveiviiiiiiiieeeeeees 23

start of video stream and Action
when the video stream is stopped
to specify the actions to be taken

when the video stream sta ....... 53
Start SeeTec Surveillance............. 23
Static ObJeCtS ...oceevvvviiiieeeee e, 53
SIEPS .o 53
STOPS oo 53
Sreaming......ccooeceveeeiiieee e 53
streaming to......cevveeeeiiiiciiiieieeeeeeine 53

84



SUCCESSION....vvveiieeeieeeeiiieeeeeeeeeeeaans 53

suitable audio codec for the camera
to specify sound transmission...53

suitable resolution ............cccceeee. 53
ST U] o] oo ] o S 3
surveillance .........cccoovieiiiiiieinen. 53
Surveillance mode...........cccceenenenn 37
SYymantec ..o 11
SYS ettt ettt 53
SYSteM .o 37, 82
System requirements ..................... 11
tab53

tab allows you to configure and .....53
TampPering .....ccccveeeeeeeeieiiiiieeeeeeeennn 53
TCP 29
Terminate .......ccoocveeeviieee e 64
terms of the intervals between ....... 53
TSt 64, 65
EEXE. e 53
that is masked............cccceevviinennnnn 53

That is why the video server and ...53
that it is always the same image ....53

That prevents the event database
from becoming unnecessarily ...53

THE o 53
The application programming ........ 53
the archive........cccocv i, 53
the AV export .......cccveveeeeiiineeenn 53

the available servers are displayed53

the bottom of the image ................. 53
The browser starts ..........cccoecveennen. 53
the browser window ....................... 53
the camera .......cccocevvvecvin e, 53

Index

The Camera function on the
Administration..........cc.ceceveeeeene. 53

the cameraimage.........ccocceveeeennnns 53

The camera may restart and then be
inaccessible for...........cccceeenee 53

The camera name and time are

specified ......cooovviviiiieee e, 53
the camera overview ..................... 53
the camera provides...................... 53

the case of inactivity to specify what
is to happen if the camera is
INACHIVE ..ooeeeiiiiiieeeeee e, 53

the case of inactivity to specify which
action is to be performed if the

camera is inactive.................... 53
the column ..., 53
the data volume.............cocveveennn. 53
the dialog ......cccoovveeiiiiiieiieee, 53
the exported sequence.................. 53
the hardware..........cccoceeiiiieennnn. 53
the image can be hidden............... 53

the images from the camera are
buffered on the SeeTec client

before they are displayed......... 53
the Information.........cccoeeeeveeviirinnnn. 25
the installation routine.................... 53

The length of time taken depends on

the camera........ccccocveeiiiineennns 53
the list and click the Delete............ 53
the main window............c.cccceeenee. 53
the Mask.......cccocvvveeiiie i, 53
the mask is displayed ................... 53

The masking follows the camera... 53

the masking is immediately removed

.................................................. 53
The maximum post...........ccceeeenee 53
the MDB configuration.................... 53

85



Cayuga Manual

the mode functions selected .......... 25

The motion detection windows must
be configured on the camera

dIreCtly ... 53
The Moving objects.........ccccceeeeenn. 53
The name is displayed ................... 53
The new camera is displayed ........ 53

the oldest recording is deleted and
replaced with the current
recording .....cceeeveveeeeniiieee e, 53

the OVEerviEW ..........cevvveeeiieeieeiiinenn, 53

.................................................. 53
the response iSt0.......ccccvevvvveeeenee. 53
The screen saver of the client

computer must be disabled for

MPEG........cooiiiiiiieeeiiieee e 53
the Search.........ccccccoii 53

The selected action is displayed....53
The selected actions are displayed53

The selected video codec is
displayed.......cccccoviiiiiiiiiiinenn 53

the set values if you want to make.53

the set values to apply the values
and conclude input............c....... 53

the settings for standard and alarm

recording ......cccevvvvvvveeeeeieneeeneee, 53
the settings Of ........oooviiiiiiiiiiee 53
The settings of the camera are

displayed.......ccccooviiiiiiiiiiiienn 53
The software creates...................... 53

the time after which the action is to
be performed if the camera is
INACHIVE ..ceveeeiee e 53

The time and path for the export are

specified .....cccoveeiiiiciieeee 53
the video hardware.............c.......... 53
The video settings include.............. 53

the video stream is transmitted ..... 53

the video streams simultaneously on

the video streams you can specify
and configure..........cccccoiiinnnen. 53

The voice quality for the G711 codec

.................................................. 53
The voice quality for the G726 codec
.................................................. 53
Theremaybe ... 53
These OCCUr.......ceeeviiiieiiieeeee 53
This normalizes fluctuations.......... 53

This prevents the user from seeing
these areas........cccovcvveeevnieeeenns 53

This reduces the image data to the

Set frame.......ccevevevieiiecieee 53
tilt 53
TIME.eeeee e 37,53,79
Time Manager .......ccooecvvveeeeeeennnns 63
time template that you create......... 53
timeline ... 45
tMEeOUL ... 29,73
title to be displayed........................ 53
TM. 11
to 53
to be exported......ccccceevviiiiiiienennns 53
to compress the exported data after

EXPON . eeeeeieeieveeeeeveveeeeeeeeeneeenenes 53
to CoNfirMm ....coocveeii 53

to correctly control cameras that are

mounted upside............cccevveeen. 53
o Create.....oooeevviiieiiiiieieeeecee, 53
o0 (<11 53

to give the user the option of moving
the camera using the PTZ control
field and preset positions.......... 53

To integrate .....ccccceeeevvicviiieeeeeeeens 53

86



to make the required settings......... 53
Toprevent ..., 53
to reduce the image quality............ 53
TOTEMOVE ... 53
To search for the camera............... 53
to specify whether .......................... 53

To test the incoming camera signal53

to the hardware ..........ccccccovveeennnn 53
to the multicast server again........... 53
triggers for ... 53
TTL e 53

UDP ..ttt 29
Ultimate ..o 11
uninstall ..., 18, 19
uninstallation ..........ccccocevevneens 18, 19
Update timeline ..........ccoccvieeeeeenn. 45
URL .o 64, 65
USE i 32
Use Active Directory.........cccuvveeee... 23
Use the joystick to move the camera

to the required position ............. 53
USEI e 69
user interface .........ccccocvvvnvecnneen 25
user name and password............... 53
User-defined installation................. 17
User's Guide..........cccveeviiveeennnnn 5,34
VIDEO .. 67
Video classifications.............c......... 73

WIEN e 53
Video gateway......ccccccoeeecvvvveeneennnnn 53
video server configuration.............. 53

Index

video server unit........c.ccocevveneeennnn. 53
Video Sstreams........cccoccvveevnieeennnnn 53
Video Walls .....cooovvvveiiiiiieiiecen, 67
VideoteC DCZ ........cccoccvveiiiienennen 29
VIBW ..t 31
VIEW MENU ...oeeiiiiiieiiiieee e 31
virtualized .......cccoocoviiiiie 5
VOIP oo 29

VolIP corresponds roughly to the
sound quality of ...........cceeeenen 53

VolIP corresponds roughly to the
sound quality of the ISDN

standard.........ccoceeeveiiinenneen 53
WallgartenstraRe ..........cooccvvveeeeeenn. 1
WED ..o 65, 82
Web pages ......ccooeveeeeiiiiiiiieeeeen 65
WEDCAMS ..o 65
When there are differences........... 53
when there are events.................. 53

which multimedia database is used
orthesize of ......covvvveeeiiieiirinnnnn, 53

which the recordings are to be stored
after the time limit is exceeded. 53

while the camera settings include . 53

WIAE oo 53
WiNdOWS .......oovveiiiiieiiieeee 26,31
Windows Explorer.................... 80, 82
WiNndows Server ........coccevvveeennnne. 11
with cameras that have.................. 53
with this camera..........cccccooeveeenne 53
within which ..., 53
Wizard........ccooeeviiiiiiiiee 61
XML file .o 62, 80

87



Cayuga Manual

Y

YA ..iiiiiiiiieie et 82
you can redirect the control signals of

.................................................. 53
You can rotate the image............... 53

You can select either Delete to delete

You can SPecCify .......ccccvvvveereeeiiinns 53

you can use the Rotate image
fUNCHION .. 53

You can use the Static objects...... 53

You specify the exact period using 53

88



	1 Legal notice
	Copyright
	Patent and copy protection
	Address

	2 Support
	Reporting a software problem by email

	3 Introduction
	Product lines

	4 Functional overview
	Surveillance mode
	Archive mode
	Event analysis
	Configuration mode

	5 Installation
	Information on installation
	Setup types
	5.1 System requirements
	5.1.1 Client (32-bit/64-bit)
	Hardware
	Software

	5.1.2 Server (32-bit)
	Hardware
	Software

	5.1.3 Server (64-bit)
	Hardware
	Software


	5.2 Standard installation
	5.3 Native client installation
	5.4 Distributed server installation
	5.5 User-defined installation
	5.6 Updating
	Optional uninstallation and updating

	5.7 Repair and uninstallation
	Optional uninstallation


	6 Login
	Logging in for the first time
	Advanced options

	7 User interface
	7.1 Menu bar
	7.1.1 The menu bar
	7.1.2 File
	File
	Client configuration
	Change language
	Change password
	Change profile
	Change user
	Switch installation
	Add SeeTec installation
	Disconnect SeeTec installation
	Tidy up list of SeeTec installations
	Count analysis

	Client configuration
	Network
	Client
	VoIP and SIP
	Input devices
	Restrictions and special cases



	7.1.3 View
	Adding a window
	Display agent
	Keeping the aspect ratio
	Video wall dispatcher
	LPR master data editor

	7.1.4 Extras
	Multiple export of image data
	Removing write protection from recordings

	7.1.5 Info
	Activating a license online
	Displaying a license

	7.1.6 Help
	User's Guide
	Start problem recording


	7.2 The mode bar
	7.3 The control bar
	Showing/hiding a tab
	Search


	8 Surveillance mode
	Camera operation
	Tabs
	Control bar
	Alarm list
	8.1 Main window
	Creating layers
	Displaying objects

	8.2 Camera image controller
	ISearch

	8.3 Camera overview
	Searching for an object

	8.4 Control
	Joystick (1)
	Buttons (2)
	Patrol (3)
	Starting a patrol
	Stopping a patrol
	Pausing a patrol
	Canceling a patrol
	Repeating a patrol
	Navigating between points in the patrol

	Camera audio (4)


	9 Archive mode
	Editing an area
	9.1 ISearch
	Creating a search area
	ISearch in surveillance mode
	ISearch in archive mode


	10 Event analysis
	Filtering the analysis
	Exporting the analysis
	Searching for an event

	11 Configuration mode
	Configuration wizard
	Additional settings
	11.1 Company
	Creating a location (1)
	Editing a location (2)
	Deleting a location (3)
	Displaying a location overview (4)

	11.2 Administration
	11.2.1 Administration
	Functions
	Editing menu

	11.2.2 Camera
	Creating a new camera
	Configuring a camera
	IP camera/video server configuration
	General
	Digital inputs
	Digital outputs

	Camera -name of the camera-
	General
	Image storage
	Video streams
	Audio settings
	Video gateway
	Camera positions
	Image data export
	Camera motion detection
	Tampering
	Privacy masking settings


	Deleting a camera
	Duplicating a camera

	11.2.3 Other hardware
	Creating new hardware
	Configuring hardware
	Deleting hardware
	Duplicating hardware

	11.2.4 License plate groups
	Creating a new license plate group
	Configuring a license plate group
	Deleting a license plate group
	Duplicating a license plate group

	11.2.5 Time Manager
	Creating a new time manager
	Configuring a time manager
	Deleting a time manager
	Duplicating a time manager

	11.2.6 Buttons
	Creating a new button
	Configuring a button
	General
	Action

	Deleting a button
	Duplicating a button

	11.2.7 Web pages
	Creating a new web page
	Configuring a web page
	Deleting a web page
	Duplicating a web page

	11.2.8 Maps
	Creating a new map
	Configuring a map
	Deleting a map
	Duplicating a map

	11.2.9 Video walls
	Creating a new video wall
	Configuring a video wall
	Deleting a video wall
	Duplicating a video wall

	11.2.10 Layers
	Creating a new layer
	Configuring a layer
	Deleting a layer
	Duplicating a layer

	11.2.11 User
	Creating a new user
	Configuring a user
	General
	Password
	Rights options
	Manage user rights
	Manage administrative rights

	Deleting a user
	Duplicating a user

	11.2.12 Groups
	Creating a new group
	Configuring a group
	General
	Rights options
	Managing user rights
	Managing administrative rights

	Deleting a group
	Duplicating a group

	11.2.13 Profiles
	General
	Image settings
	Video classifications
	Single image (Motion JPEG, MxPEG)
	Streaming (MPEG-4, H.264)
	Video wall module mapping


	11.2.14 Alarms
	Creating a new alarm scenario
	Configuring an alarm scenario
	General
	Start
	End
	Visualization
	Persons involved
	Server
	Email and FTP

	Deleting an alarm scenario
	Duplicating an alarm scenario

	11.2.15 Patrols
	Creating a new patrol
	Configuring a patrol
	Deleting a patrol
	Duplicating a patrol

	11.2.16 Sequences
	Creating a new sequence
	Configuring a sequence
	General
	Actions

	Deleting a sequence
	Duplicating a sequence

	11.2.17 Server
	CoreService
	Global OCR settings
	Device Manager
	General
	Options
	Image data export


	11.2.18 System
	Backup
	Company calendar
	SMTP server
	Email Manager
	SNMP server
	NAT list
	Event Manager
	General
	Error/warning/info

	Entity numbers
	Video classification



	12 Index

